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The new MDSHA V8 CAD standards and workspace were the result of a great deal of effort
and coordination. The final product incorporated resources and comments from MDSHA, the
consultant community and from members of the Consulting Engineering Council of
Maryland. Thus, given the above and the fact that there are numerous streets which are either
bordered by Maryland on one side and DC on the other, or that run through both
jurisdictions, DDOT made the decision to adopt the Maryland State Highway Administration
(MDSHA) CAD Standards.
Incorporated in the MDSHA workspace are numerous macros and tools that aid in increasing
productivity as well as in ensuring compliance with the CAD standards. DDOT has
incorporated these macros and tools into its workspace with minimal, and mostly cosmetic,
modifications. The MDSHA CAD Standards Manual is also the source and foundation for
most of the DDOT CAD Standards Manual. Doing so offers DDOT two benefits: First, the
consultants that work on projects in both jurisdictions would not need to learn a new set of
standards or tools. Second, the association with MDSHA will facilitate the CAD standards
adoption to occur faster than would have been possible had DDOT undertaken to develop all
the tools and macros it needs.
The MDSHA workspace and tools are expected to evolve over time to better serve its
personnel and the consulting community. As major modifications are made by MDSHA,
DDOT will evaluate the updates, and if deemed advisable, update its workspace and replace
applicable sections of its CAD Standards Manual.
We want to thank MDSHA personnel and acknowledge the support they provided as DDOT
was modifying the SHA workspace and CAD Manual to meet its needs. MDSHA had
graciously shared the electronic files needed for the Workspace and CAD manual and
extended permission to DDOT to modify and/or adopt any of the files as needed for the new
DDOT Workspace and CAD Standards Manual. SHA personnel were very generous with
their time, answered numerous questions and provided invaluable help in customizing the
Workspace.
The DDOT Workspace, V8 CAD Standards Manual and associated support files will be
distributed to consultants on a CD. DDOT employees will also be able to access these on the
server and should contact their IT manager for guidance. The guidelines contained in the
DDOT CAD Standards Manual are to be followed for all DDOT projects.
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Introduction
This chapter introduces the contents of the DDOT MicroStation V8 CAD Standards. This
chapter’s major sections describe the intended audience and the purpose of this manual.

About This Manual
This manual is specifically written for MicroStation V8, and it is hoped that this manual will
serve as the single information source related to the use of MicroStation V8 at DDOT for all
Offices and Divisions.
The manual also marks DDOT’s migration to utilizing CAD for drafting and design and
specifically its commitment to use MicroStation V8 and related engineering design add-ons
and custom applications. As stated previously, since the DDOT Standards and Workspace
mirror the MDSHA Standards and Workspace, the CAD Manual will also be updated as
major updates or changes occur in the Maryland CAD standards or workspace. The CAD
manual and workspace might also be updated as major changes are introduced in
MicroStation or Geopak, or as the need arises due to changing or unaddressed needs at
DDOT. Updates will be performed by authorized personnel only. No part of the CAD
Standards and Workspace, including cells, fonts, text sizes, etc. are to be revised without
directions from the Chief Engineer or authorized representative. Suggestions are strongly
encouraged and should be directed to Mr. Ardeshir Nafici, Chief, Program Management
Support Division, IPMA at (202) 671-4689.

Serving the Needs of CAD Users
This manual serves the needs of several groups of CAD users. DDOT personnel as well as
consultants tasked with a project for DDOT will find tables that will help them use the
provided tools to set the desired symbology (level, color, weight and style) for design
elements. Following the guidelines set in this manual will ensure that the drawings produced
are consistent with the most current DDOT CAD Standards. In addition, construction
contractors will find that this manual and appendices will help them better understand the
drawing symbols and setup, especially when called upon to prepare shop drawings, changed
field condition sketches, redline drawings and the like.

Purpose
Users will find that properly using the concepts and tools outlined in this manual will better
equip them to produce high-quality CAD drawings more efficiently and consistently. Thus,
the purpose of having a CAD standards manual and the tools and associated electronic files
can be categorized into three main areas:
1)Quality of Deliverables: The documentation of DDOT’s CAD Standards will aid in
creatingdeliverables that have a consistent and superior quality.
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2) Efficiency in Design through Tools: The cell libraries, menu files, standard details and
other files that accompany this manual are designed to help users quickly place standard
graphical elements with just a click or two. Additionally, the custom design tools and macros
adopted from the SHA Workspace let users more efficiently create design elements,
including drainage structures, traffic signals, right-of-way plats, bridge detail sheets and more
in the drawing files.
3) Consistency between Offices and among Consultants: Use of the details, symbols, seed
files and other elements that are part of the DDOT CAD standards will ensure that drawings
will conform to DDOT’s requirements and are consistent—whether projects are done by
consultants or DDOT personnel.
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Chapter 1
DDOT Workspace
Introduction
This chapter provides an introduction to the DDOT Workspace that has been developed for
use with MicroStation V8. This workspace helps users manage the V8 drafting environment
by delivering standard elements such as resource files, cells and level libraries, as well as
several custom tools and macros developed by DDOT for V8. Details are provided for both
users and administrators. This chapter’s major sections are listed below:
1) Minimum System Requirements
2) Using the DDOT Workspace shows the MicroStation Manager window and
what Workspace Options should be selected to obtain the new V8 CAD
Standards.
3) Workspace Setup provides instructions on how to install the Workspace, with
notes for both Internal DDOT Users and External Consultant Users.
4) Workspace Options explains how MicroStation’s Workspace Options are
being implemented at DDOT, including User, Project and Interface.

Minimum System Requirements
The January 2005 release of the V8 CAD Standards has been designed to run on
MicroStation V8.01.02.15. Please refer to Bentley documentation for product system
requirements.

Using the DDOT Workspace
The workspace delivered with this CAD Manual has tools that help increase productivity as
well as help users comply with the CAD Standards. As stated before, the Workspace and
tools were developed by MDSHA and have been adopted by DDOT with modifications to
better fit the needs of DDOT personnel.
When you start MicroStation using the DDOT Workspace, the MicroStation Manager dialog
box will appear with various options in the Workspace section:
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NOTE: Generally speaking, the only option that needs to be selected is that of User,
to select the proper CAD Standard version. As of January 2005, the User
workspace that should be used for new projects is “DDOT_V8_01”. For
notes on other User Options, refer to the Workspace Options section.
Upon loading the MicroStation, the user will immediately know that they are in the DDOT
Workspace by the presence of the DDOT Main Menu and Toolbox.

The Main Menu has pulldowns that allow the user to select additional discipline-specific
menus, set drawing scale factors and access various custom tools to assist in the drafting
process. The DDOT Workspace does not disable any of the MicroStation tools delivered with
the software, but offers additional tools that help users adhere to various requirements of the
CAD standards such as element symbology, level name, file name, etc.
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Workspace Setup
Internal DDOT Users
Within IPMA, the V8 workspace is planned to be implemented across the local area network.
This will ensure that all CAD workstations have access to the latest version of tools and
settings as they are developed. For instance, if a resource file has been updated, it need not be
installed on each computer, but simply added to the network workspace for all users at IPMA
to receive the update. The setup of other DDOT agencies has yet to be determined.
To setup the network workspace on a user’s machine, perform the following steps:
1) Install MicroStation V8.
2) Copy the mslocal.cfg file from the LAN Workspace directory, eg: for IPMA one
might use S:\CAD\Workspace\mslocal.cfg
3) Paste to overwrite the mslocal.cfg file on the local machine typically C:\Program
Files\Bentley\Program\MicroStation\config\mslocal.cfg
This will redirect the Workspace root to the network location. Not only will resource files
and other standard files be maintained on the network, but a directory will automatically be
created for each user to store the following custom support files:
•
•
•
•

user preference (*.UPF) files
user interface (*.M01) files
function key menu (*.MNU) files
custom configuration (*.CFG) files

Storing these files on the network promotes portability of each user’s custom settings. If a
user moves to a new workstation or has their current workstation rebuilt, all settings will be
retained. Note also that this is a one-time setup. If new standards are released in the future,
they will automatically pass to the user.
External Users (Consultants)
For external consultant users, the DDOT Workspace is provided on the accompanying CD
and is also available for web download. The workspace provides the core functionality of
DDOT’s network workspace, minus certain CAD management aspects.
NOTE: It is recommended that the Workspace be installed on the network, although
installation on the local machine will also work.
1) Unzip the files to a network or local directory.
2) Open the file..\Workspace\startup.cfg in a text editor.
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3) Redefine the _USTN_WORKSPACEROOT variable to point to the location of
the Workspace folder as determined in step 1, then save and close the file.
4) Create a desktop shortcut to V8.
5) Right-click the shortcut and select Properties.
6) When the Properties box opens, append the following text to the Target field (note
that it begins with a space):
-wc”[path]\Workspace\startup.cfg”
where [path] defines the full directory path of the Workspace.
eg: -wc” S:\CAD\Workspace\startup.cfg”
Note: There is no space between wc and the quotation mark.

Click OK.
You should now have a desktop shortcut that will
launch the DDOT Workspace. Users should take care
to always load design files for DDOT projects
through the shortcut, otherwise the following
workspace options will not be available.

Workspace Options
The combination of User, Project and Interface determines the user’s working environment
for MicroStation. The significance of these options is explained below.
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User
The user has the choice of having the DDOT CAD Standards launched when a file is opened
or of using the default MicroStation workspace. However, it is greatly encouraged that users
select the DDOT V8 01 workspace. This option delivers the new V8 CAD standards and
should be selected for any new projects that are to be performed using the V8 design file
format (unlimited named levels, etc). V7 files will always be opened as read/only.

Project
The DDOT Workspace does not rely on the Project setting to manage project design files and
resources. Rather, this setting is used in-house by some divisions to define certain disciplinespecific settings and standards.

NOTE: For most DDOT users, the Project setting will be preset based on user login
and does not need to be changed!
External consultants may continue to use the Project configuration as needed to define
specific project working directories, etc.
Interface
The choice of Interface determines what custom pull down menus and toolboxes a user will
receive. Depending how it is set up within the organization, this setting could reflect the
user’s network login name, which would allow individual customization.

For the consultant workspace, the user interface variable is not explicitly defined so users
should continue to see the same Interface options that they normally would.
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Chapter 2
Custom Tools
Introduction
This chapter provides an overview of the modifications to the default MicroStation
workspace, and the custom applications and tools developed by MDSHA and made available
through the DDOT Workspace. These tools and applications are intended to simplify,
standardize and make the creation of CAD drawings more efficient.

Main Menu
Upon entering the DDOT Workspace, the Main Menu will appear, along with the IDS
Toolbox. The Main Menu contains key pulldown commands that are applicable to any file in
the Workspace.

NOTE: The Main Menu should always remain loaded. Should it become unloaded or is not
visible, there are three ways to reload it. One could either key-in “mdl load DDOTbarmenu”,
use the DDOT pull down menu as shown below or access it from the IDS Tools menu by
clicking on the “d.” tool.

•

The Menus pulldown contains links to discipline-specific menus:
Selecting one of the items from the Menus pulldown does
the following:
1) Unloads the current discipline-specific menu
2) Unloads the attached level libraries
3) Loads the selected discipline-specific menu
4) Loads the appropriate level libraries
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•

The Scale pulldown contains commands that allow you to set the file’s drawing scale.
Typically this is done once, at the time the file is first created. The active scale will be
displayed along the top of the MicroStation window.

MicroStation V8.1 – This version
uses the Linestyle Scale Factor as the
de facto drawing scale.
MicroStation 2004 – This version
uses the Model Annotation Scale as
the de facto drawing scale.
NOTE – when first opening a file in
2004, it may be necessary to reset the
drawing scale and the Text Styles
(Tools > Import DDOT Text Styles)
if the file was originally created
using V8.1.

•

The Tools pulldown contains links to various drafting tools, both custom developed and
MicroStation delivered.
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•

The Help pulldown contains links to the DDOT CAD Manual, as well as information
about the current version of the Workspace.

Discipline/File Specific Menus
Many additional barmenus have been created based on file discipline (e.g. Roadway Design,
Drainage Design, etc) or general file type (e.g. Plan Sheet, Title Sheet). When a file is first
opened, the Workspace checks the file name to see if it follows the standard file naming
convention. If there is a match, the appropriate barmenu will be automatically loaded, along
with any associated level libraries. As noted above, these barmenus may also be selected
from the Main Menu > Menus.

DDOT (IDS) Toolframe
The DDOT (IDS) Toolframe is a collection of MicroStation V8 tools, and is automatically
loaded by the Workspace. If it is unloaded or not visible, select Tools > IDS Toolbox from
the Main Menu, or key-in “mdl load idstb”.

DDOT Barmenu
DDOT Tools

File Naming Wizard
Feature Search Tool

DDOT Barmenu
This button opens the DDOT Main Menu.
DDOT Tools
This toolbox contains a collection of design production tools for signals and signage, area
measurement, grid tick placement, placing callout labels and changing symbology.

Signal Tools

Level Symbology

Sign Tools

Place Label

Area Impact Tool

DDOT CAD Standards
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Signal Tools
The SIGNAL TOOLS assist the user in placing symbols for existing and proposed signal
poles and mast arms. The dynamic tool allows the user to interactively specify mast
arm lengths and quantity and number of signal heads per mast arm.
Sign Tools
The SIGN TOOLS assist the user in creating guide signs based on MUTCD standards.
Area Impact Tools
The area impact tools provide a method for measuring, filling and labeling a specified
area in one command. The color, fill type, level, measurement units and label units
can all be adjusted by the user.
Place Label
The place label tool quickly creates callout labels for such things as limits of work.
Grid Tick Placement Tool
The GRID TICK PLACEMENT TOOL assists the user in placing grid ticks on plan sheets.
By default, the grid ticks are locked to a grid interval of 250 ft. One to three grid ticks
can be placed. The size of the tick is automatically scaled according to the file’s
drawing scale.

Change Level Symbology
Change Level Symbology allows the user to change level symbology of an element or
of an entire file. This will not change the actual symbology attributes of the element
but only how they are displayed if Level Symbology is turned on. Level symbology
must be checked in the view attributes dialog in order for the user to see the changes.
File Naming Wizard
The FILE NAMING WIZARD helps users create files in accordance to the file naming
convention. Refer to the “File Naming Convention” section in Chapter 3 for more
information. The File Naming Wizard dialog box is shown below:
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Feature Search Tool
The FEATURE SEARCH tool is an interface developed to help browse the CAD Standards for
unknown symbology settings.

DDOT CAD Standards

Chapter 2-5

2005

Notes 

DDOT CAD Standards

Chapter 2-6

2005

Chapter 3
CAD Files Management & File Naming Convention
Introduction
This chapter’s major topics are:
•

File Naming Convention: The new DDOT file naming convention requires that file names
follow the format discussed below. This chapter provides details on how to name
MicroStation V8 CAD files. Topics include the explanations of two components of a
standard CAD file name: File Group and the File Discipline.

•

File Naming Wizard: The File Naming Wizard has been incorporated within the DDOT
Workspace and is explained in this chapter. It is a tool that can be used to ensure that files
are named correctly. The File Naming Wizard is adopted from MDSHA’s workspace. Use
of this tool makes it easier to create files with a naming structure that adheres to the new
standard.

•

Renaming Files: This chapter includes a discussion on renaming a file after it has been
created by the File Naming Wizard.

•

File Management and Directory Structure: The section on directory structure for CAD
files discusses how CAD files must be organized and maintained for DDOT projects. This
convention has to be followed for all projects, including those designed in-house and/or by
consultants.

Purpose of Establishing a Naming Convention
There are several advantages to keeping design elements in separate files instead of keeping
everything in one MicroStation file. Multiple design files are required for most types of
projects. The DDOT CAD Standards require that each of these design files have a unique
name that will adhere to the naming structure discussed herein, and be located in the
appropriate directory.
This chapter will describe the CAD files naming convention that needs to be followed for
each design file and will also discuss directory structures. Standard and nonstandard file
types and file naming conventions are also explained. The new standard requires that a CAD
file name consists of three segments, each separated by a dash (-) and an underscore (_). This
section will describe in detail these three segments starting with the format for the first
segment of CAD file name, followed by the format for the third segment and concludes with
a discussion of the middle segment of CAD file name.
Having an established file naming convention and directory structure will be beneficial under
multiple scenarios:
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Project designed by DDOT personnel: Multiple individuals will work on most projects. If
DDOT personnel follow the new DDOT Standards file naming and directory convention, all
team members will know exactly where each file is kept and will know the specific file to
open if needed either for review purposes or to work on a certain aspect of the design. If an
employee working on a project is unavailable, others will be able to step in and continue on
the project with minimal disruption. In addition, supervisors will know the directory and file
name that has the information they want to check or review.
Projects Designed By Consultants: All work performed by consultants for DDOT projects
which start after the release of the CAD Standards manual must follow the file naming and
directory structure guideline of the new DDOT CAD Standards. Upon design completion,
consultants are expected to submit the electronic version of the design files as specified in
Chapter 6, titled Electronic Data Deliverables. If a consultant follows the new file naming
and file structure convention, DDOT personnel and other consultants will find it easy to
determine which electronic file submitted by a consultant has the information they are
seeking.

The New DDOT File Naming Convention
DDOT has adopted Maryland’s SHA, MicroStation V8 CAD file naming convention. The
file naming convention discussed in this chapter is to be followed for all CAD files and all
Tiff files, the only difference between the two being the three-character file extension. The
extension for all CAD files will be “.dgn”, while the extension for Tiff files will be “.tif”. If
one is conducting review of a file, the file name will be the same as the file being reviewed,
but the extension will be the default “.rdl”.

CAD file names must follow the following format:
gDD-TTNN_ProjectID.dgn
where:
g
DD
TT
NN
ProjectID

=
=
=
=
=

one-character File Group
two-character File Discipline
two-character Sheet Type
two-character Sequence Number
six digit ProjectID

File Naming Convention for the First Segment of a CAD File Name
Under the new file naming convention, the format of the first 3 characters of file names is
consistent for all CAD files and is always a one character File Group followed by two
characters which signify the File Discipline. However, the format of the remaining
characters will vary based on the contents of the file for the specific discipline.
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File Group
The new file naming convention requires that the first character of a CAD file signify the
general function of the file. For instance, some files are solely used as reference files, while
others are intended for plotting. CAD files are classified into five general function categories,
which are referred to as File Groups. Thus, the first character of the file name will designate
the File Group to which it belongs.
The five File Groups are identified by a single-letter abbreviation, which is used as the first
character in the file name. This first character in the file name essentially specifies whether a
file functions as a reference file, as the final plotted output file or as a file that is neither
plotted nor referenced into plan sheets.
The five File Groups and their one-character abbreviations are:

Reference Files

p - Print Files/Contract sheets: Files which are used to generate the final
construction plot files are composed of various design files that are referenced into
the master sheet file. These files are printed to deliver the final products of DDOT
CAD, whether they are contract documents, plan sheets, profile sheets, cross-section
sheets, schedules, brochures or wall displays. Any file that is plotted to generate a
final contract document falls into this group.
m – Model/Design Files: Reference files which form the basis for the project
design. These files will be referenced to final Print files (see above). These
files contain existing and proposed design elements such as centerlines,
profiles, edge of road, MOT plans, signing, pavement marking, crosssections, etc.
d - Detail Files: Reference files that contain design details such as typical
sections, street light details, drainage details, curb details, etc.
x -Miscellaneous Files: Reference files that do not fall easily into one of the
other Reference file categories. This could, for example, include the border
file.

s - DGN Support/Work Files: Files that are critical to the CAD design process but
are neither plotted nor referenced into plan sheets. Such files may be necessary for
use of design software (e.g. Geopak pattern files) or may simply be used for
engineering, calculations and measurements by the designer.
The majority of files used in creating contract documents will be either an m-model file or a
p-print file. An illustration of the CAD File Group hierarchy with some example file types is
displayed in the chart on the following page.
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Examples:
Plan, profile and
cross-section
sheets, wetland
plats, right-ofway plats,
construction
drawings, and
redlines as well as
public display
drawings and

Files that
represent final
output (e.g., plan
sheets) or other
display sheets

(p) Print Files
Sheet/Display

Chapter 3-4
Examples:
Alignment files,
hydraulics files,
TCP phases,
and erosion and
sediment
control phases

Coordinatelycorrect design
files that model
proposed design
features across
the entire
project

Proposed

Existing

Examples:
Topographic,
as-built, rightof-way, utility
files

Coordinatelycorrect design
files that model
existing features
across the entire
project

(m) Models
(References)

Examples:
Bridge details,
drainage details,
signal details,
mechanical
details, etc

Detail drawings
that are not
directly printed,
but rather, serve
as reference files
for the detail
sheet

(d) Details
(References)

Reference Files

CAD File Groups

Examples:
Border files, etc

CAD files that do
not fall easily
into one of the
other reference
file categories

(x) Misc.
(References

Examples:
“Work” files,
scratch files,
pattern and
shape files for
GEOPAK,
quantity
estimating files

Files that are
critical to the
CAD design
process but are
neither plotted
nor referenced
into plan sheets

(s) DGN
Support

File Group Chart
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File Discipline
The second and third characters in a file name identify the File Discipline. The two-character
abbreviation specifies the exact type of information contained in a file. For example the twocharacter abbreviation for Contours is CT, for Right of Way, RW, for Highway Profile, HP
and for Geopak Pattern Lines, PT. The complete list of File Disciplines delivered with the
Workspace is shown in Table 1.
However, this list of two-character abbreviations provided with the new DDOT CAD
Standards does not cover all possible information that might be shown in a design file. If
none of the provided abbreviations describe the specific type of information to be shown in
the design file, a File Discipline abbreviation that defines the broad discipline of information
appearing within a particular design file shall be used. Examples of broad descriptions of
disciplines and their two-letter abbreviation include: Topography (TO), Highway Design
(HD), Landscape Design (LD) and Signing (SN). As shown in Table 1, abbreviations for a
large number of design disciplines have been provided as part of the CAD file naming
convention and workspace.
It should be noted that the File Discipline abbreviations available to choose from will differ
depending on the File Group and are very limited for files in the following three File Groups:
Support files, Detail Reference Files and Miscellaneous Reference Files. Five File
Disciplines are available for Detail Reference Files: Bridge/Structure (BR); Drainage (Plan)
Design (DD); Erosion & Sediment Control (ES); Highway Typical (HT); and Stormwater
Management (SW). Three File Disciplines are available for Miscellaneous Reference Files:
Base Line (BL), Layout (LA) and Legend (LG). Three File Disciplines are available for
Support Files: Air Quality (AQ), Highway (plan) Design (HD) and Pattern Lines (PT)
(Geopak patterns).
If users cannot find a sufficiently descriptive File Discipline for some of these file groups, it
is recommended that they rename the file after creating it using the File Naming Wizard.
Please refer to the discussion below on Renaming Files Created with The File Naming
Wizard.
It is important to note that File Discipline abbreviations can be used for more than one File
Group. For example, the File Discipline abbreviation HD is used for all of the following File
Groups: Sheet files, Model Reference Files and Support Files. The first three characters of
the file name for these three groups will be pHD, mHD and sHD.
Table 1 offers a large selection of abbreviations for File Discipline. However, if none of the
choices from the list fit the content of the CAD file being created, users are encouraged to
inform the contact personnel shown in the Intoduction with their recommendation for
additions.
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Table 1 – File Discipline
Abbreviation
AQ
BL
BR
BG
CT
XL
XS
DD
DA
DP
ED
EF
EI
ES
FD
GN
GS
GD
GR
GM
HD
HC
HP
HT
IT
LU
LD
LP
LA
LG
LT
MT
MB
MO
NA
NB
PT
PM
PL
CL
RR
RF
RW
SC
SH
SG
SN
SO
SM
SW
SD
SR
ST
SE
SC
TO
TX
TT
TM
TR
AT
UT
WD
WT

Info Contained in File:
Air Quality
Base Linen
Bridge / Structure
Brochure Graphics
Contours
Cross Section Layout
Cross sections
Drainage (Plan) Design
Drainage Area
Drainage Profile
Environmental Document
Environmental Features
Environmental Impacts
Erosion & Sediment Control
Future Developments
General
Geometry Sheet
Geomety design-(ER, EP,Sidewalk, curve data, driveway, etc)
Grading (Contours)
Grid Map
Highway (Plan) Design
Highway Cross Section
Highway Profile
Highway Typical
ITS (Intelligent Transportation Systems)
Land Use
Landscape (Plan) Design
Landscape Profile
Layout
Legend
Lighting
Maintenance of Traffic (MOT)
Metes & Bounds
Mosaic
Noise Abatement
Noise Barrier
Pattern Lines (Geopak)
Pavement Marking
Property Lines/Plat Development
Proposed centerline
Railroad (Plan) Design
Reforestation
Right-of-Way
Sequence of Construction
Shading
Signal Design
Signing
Soils & Foundation
Soils Map
Stormwater Management
Stream Diversion
Stream Restoration
Structures
Superelevation Shapes (geopak)
Survey Cookies
Topography (survey)
Topography (survey) Text
Topography to Remain
Town Map
Triangles
Turning Movements (AutoTurn)
Utilities
Wall Display
Wetlands
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File Naming Convention for the Third Segment of a CAD File Name
(ProjectID)
The third segment of a CAD file name will consist of six numbers that identify the project.
Unless directed otherwise by the DDOT project manger, the six-digit code will be the
Purchase Order number shown on the Notice to Proceed. For projects performed in-house by
DDOT personnel, the Chief Engineer or his designated representative will assign the six-digit
project code to each project. It is the responsibility of the project manager or project engineer
to ensure that they receive the correct six-digit project number at the start of a project.
The third segment of a CAD file name is added to make each file name unique because the
first and middle segments are the same for every project containing that type of information.
(For example, the first and middle segment of reference file names that contain survey
information will be the same for all projects). DDOT plans to put in place document
management software in the near future, and the document check-in and checkout process
will be streamlined if each file name is unique.
The six numerical characters that form the third segment of a CAD file name are abbreviated
in the discussions that follow by the symbol ProjectID. It will have the following format:
ProjectID = CCCCCC
Where CCCCCC = Project Code (6 digits)

File Naming Convention for the Middle Segment of a CAD File Name
The middle segment of a CAD file name will have four alphanumeric characters whose
format and content is determined by the first segment of the file name. These four characters
will be separated from the File Discipline by a dash (-), and will be separated by an
underscore ( _ ) from the ProjectID. The first two characters of the middle segment of a CAD
file name are known as Sheet Type and the last two as Sequence Number.
Sheet Type
The first two characters of the middle segment of a CAD file name represent the Sheet Type
and will follow one of the formats discussed below. The sheet type can be a one-character
descriptor followed by a zero as a placeholder or both characters can be set to two zeros by
the File Naming Wizard. Due to the fact that a File Discipline abbreviation is not provided
for some types of file contents, there will be instances where a user might need to rename a
file that has been created with the File Naming Wizard. Doing so allows the use of a twocharacter descriptive abbreviation that will let everyone know at a glance the file content. For
example, a File Discipline abbreviation is not provided for Model (Reference) files which
contain just the centerline of the project. Thus for projects in which the designer prefers to
have the centerline information shown separately from other geometry information, the File
Discipline for the file name can be set to HD for Highway Design, and the file will be
renamed using “CL” for Sheet Type. Thus the portion of the file name preceding the
sequence number will be mHD-CL
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If files created using the File Naming Wizard are renamed on a project, an electronic file
must be submitted that explains any abbreviations used that fall outside of those delivered
with the Workspace. (See the Electronic Data Deliverables chapter in this Manual). Also,
refer to the discussion below on Renaming Files Created with The File Naming Wizard
for some abbreviations and formats that can be used when renaming a CAD file.
Sequence Number
The last two characters of the middle segment of a CAD file name are known as the
Sequence Number and indicate either the sheet number for Print/Sheet files, or the site or
segment number of Model and Support files. If one of these is not specified, the File Naming
Wizard will assign two zeros to the Sequence Number.
For multi-site or multi-segment projects, consultants will provide a file with each electronic
submittal that describes the site number or segment number convention for the project. (See
the Electronic Data Deliverables chapter in this Manual)
The paragraphs below will first describe the abbreviations and formats that will be given to
the middle segment of a file name by the File Naming Wizard, and will be followed by a
discussion on The File Naming Wizard and on renaming a file after it has been created by the
File Naming Wizard.
The two characters of the Sequence Number are represented as NN in the discussions below.
1 - Format for the Middle Segment of a Print/Sheet File Name
Depending on the file discipline selected for the first segment of the file name, the
Sheet Type for Print/Sheet file names will follow one of the formats below:
T0NN
TTNN
S0NN
00NN
Where

T0 = Sheet Type is represented by a one
character abbreviation (see box on right)
followed by a zero
TT = Sheet Type is represented by a two letter
abbreviation. The abbreviation will
depend on the file discipline chosen for
the first segment of the file name.
S0 = Sheet Type is represented by either an E
for existing or P for proposed, followed by
zero

T

Sheet Type
Title sheet
Index sheet
Notes
Schedules

T
I
N
S

Plan sheet
Cross Section sheet
Profile sheet
Detail sheet
Redlines
As-Builts

P
X
V
D
R
A

Figure / Plate
F
Wall Display
W
Cartography/Mapping M

00 = Sheet Type is represented by two zeros.
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All of the above four formats of Sheet Type will be followed by the Sequence
Number where:
NN = Two digit sheet number or two zeros if none is specified.
The choices for T and TT are extensive. There should be no need to rename any
Print/Sheet reference file after it has been created by the File Naming Wizard.
2 - Format for the Middle Segment of a Model (Reference) File Name
The Sheet Type for Model (Reference) files will have one of the seven formats
discussed below, depending on the File Discipline of the first segment of the file
name. For each of the seven formats, a table is included that lists the File Discipline
choices that will result in that format for Sheet Type.
The Sequence Number for Model (Reference) files will always be the site number
for multi-site projects, the segment number for multi-segment projects or two zeros
for a single site, single segment project.
A - Model (Reference) File Naming Convention– Format No. 1 (Basic File
Naming)
00NN
Where

00 =

Sheet Type is represented by two zeros, i.e. there will be no
selections available for Sheet Type.

NN = Sequence Number or two zeros if none is specified.
Thus if no Sequence Number is specified, the middle segment of the CAD file
name will be assigned four zeros by the File Naming Wizard.
The table below shows the File Discipline selections for the first segment of
Model (reference) file names that will yield a middle segment with the above
format.
File Discipline
DD
DP
EF
ES
FD
GM
LD
MT
MB
MO
RR
RF

DDOT CAD Standards

File Discipline Description
Drainage (Plan) Design
Drainage Profile
Environmental Features
Erosion & Sediment Control
Future Developments
Grid Map
Landscape (Plan) Design
Maintenance of Traffic (MOT)
Metes & Bounds
Mosaic
Railroad (Plan) Design
Reforestation
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SC
SH
SO
SM
SD
SR
TT
AT
WT

Sequence of Construction
Shading
Soils & Foundation
Soils Map
Stream Diversion
Stream Restoration
Topography to Remain
Turning Movements (Auto Turn)
Wetland

B - Model (Reference) File Naming Convention– Format No. 2 (Files
designated as proposed or existing)
Some File Discipline selections for Model (Reference) Files will yield a middle
segment with the following format:
S0NN
Where

S0 =

Sheet Type is represented by either E for existing or P for
proposed, followed by a zero.

NN = Sequence Number or two zeros if none is specified.
If any of the File Disciplines shown in the table below are chosen for the first
segment of the file name, the second segment of the CAD file name will have the
format S0NN.
File Discipline
GR
IT
LU
LT
PM
RW
SG
SN
TR

File Discipline Description
Grading
ITS
Land Use
Lighting
Pavement Marking
Existing and Proposed
Signalization
Signing
Triangles

C - Model (Reference) File Naming Convention– Format No. 3 (Files
designated by alternatives, phases, etc.)
Some File Discipline selections for Model (Reference) files will yield a middle
segment with either of the following two formats:
-AANN_ or -00NN_
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Where

AA = Sheet Type is represented by an
alternate or phase number (See
box on right for
recommendations).
00 =

Sheet Type is represented by two
zeros if an alternate or Phase
number is not provided.

AA

Alternate or Phase
Preliminary Study
Preliminary Design, 30%
completion
Intermediate Design;
60% Completion
90% Completion

04

Final Design

00

01
02
03

NN = Sequence Number or two zeros if none is specified.
The File Naming Wizard does not provide an option not to have the two zeros, or
to have non-numerical characters. The table below shows the File Discipline
selections that will yield a middle segment with the above format if the File
Naming Wizard is used.
File Discipline Description

File
Discipline
EI
HD
HC
HP
NB

Environmental Impacts
Highway (Plan) Design
Highway Cross Section
Highway Profile
Noise Barrier

D - Model (Reference) File Naming Convention– Format No. 4 (Files
designated as existing or proposed with alternates or phases)
Two File Discipline selections will yield a middle segment with one of the two
following formats:
S0NN_ or -AANN_
Where

S0 =

Sheet Type is represented by
either an E for existing or P for
proposed followed by a zero.

AA = Sheet Type is represented by an
alternate or phase number (See
box on right).
NN = Sequence Number or two zeros if
none is specified

AA

Alternate or Phase
Preliminary Study
Preliminary Design, 30%
completion
Intermediate Design;
60% Completion
90% Completion

04

Final Design

00

01
02
03

The table below shows the File Discipline selections that will yield a middle
segment of a CAD file name with one of the above two formats.
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File Discipline
DA
PL

File Discipline Description
Drainage Area
Property Lines/Plat Development

E - Model (Reference) File Naming Convention– Format No. 5
One File Discipline selection will yield a middle segment having one of two
formats:
AANN
Where

AA = Sheet Type is represented by an alternate or phase number (See
box above).
NN = Sequence Number or two zeros if none is specified

The table below shows the File Discipline selection that will yield a middle
segment having the format AANN if the File Naming Wizard is used.
File Discipline
SC

File Discipline Description
Sequence of Construction

F - Model (Reference) File Naming Convention– Format No. 6
The TO (Topography) selection for File Discipline will yield a middle segment
having the following format:
L0NN
Where

L0 =

Sheet Type is represented by a one letter abbreviation
signifying one of five file contents shown below, followed by a
zero.

NN = Sequence Number or two zeros if none is specified
The table below shows the single letter abbreviations available to choose from
and their descriptions:
File Discipline
TO

DDOT CAD Standards

File Discipline
Description
Topography

Sheet Type

Description of Sheet Type

A
C
F
R
S

Aerial (Photography)
Composite Sources
Field Located
Recorded Data
Survey
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G - Model (Reference) File Naming Convention– Format No. 7
The BR (Bridge/Structure) selection for File Discipline will yield a middle
segment having the following format:
00NN_ or -TTNN
Where 00NN = Sheet Type is represented by two zeros, if none is specified,
followed by the Sequence Number.
TTNN = Sheet Type is represented by two characters followed by the
Sequence Number.
3 - Format for the Middle Segment of a Detail (Reference) File Name
The middle segment of Detail (Reference) file names will follow the format below:
00NN
Where

00 =

Sheet Type is represented by two zeros.

NN = Sequence Number or two zeros if none is specified.
The middle segment of a file name will have four zeros if a Sequence Number is not
specified due to project not having multi-sites or segments.
As stated previously, when creating files in which to draw details, five File
Disciplines are available to choose from when using the File Naming Wizard. These
are: Bridge/Structure (BR); Drainage (Plan) Design (DD); Erosion & Sediment
Control (ES); Highway Typical (HT); and Stormwater Management (SW). For these
five File Disciplines, the Sheet Type will always be 00 if the File Naming Wizard is
used when creating the CAD file.
4 - Format for the Middle Segment of a Miscellaneous (Reference) File Name
The middle segment of Miscellaneous (Reference) file names will follow the format
below:
00NN
Where

00NN = Sheet Type is represented by two zeros followed by Sequence
Number. If Sequence Number is not specified, the middle
segment will be assigned four zeros by the File Naming
Wizard.

As stated previously, the File Naming Wizard gives a choice of only three File
Disciplines when creating files in Miscellaneous (Reference) Files group. These File
Disciplines are: Base Linen (BL), Layout (LA) and Legend (LG).
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There may be instances where Miscellaneous (Reference) CAD files have to be
renamed. Refer to the discussion on Renaming Files Created with The File Naming
Wizard for some recommended abbreviations and formats that can be used when
renaming a CAD file.
5 – Format for the Middle Segment of a Support File Name
The middle segment of Support file names will follow the format below:
00NN or Q0NN
Where

00 =

Sheet Type is represented by two zeros.

Q0 = Sheet Type is represented by Q for quantities, followed by a
zero.
NN = Sequence Number or two zeros if none is specified.
As stated previously, there are only three File Discipline choices for Support files
when creating files using the File Naming Wizard. Of these, Air Quality (AQ) and
Pattern Lines (PT) will have the format 00NN. The third, Highway (Plan) Design
(HD), will offer a choice of 00NN or Q0NN.

File Naming Convention Summary
Shown below is the full file naming convention that will be followed by the File Naming
Wizard for each of the five File Group. For files in the Print/Sheet file group, the Sheet Type
will be a one-character abbreviation followed by a zero. For the other File Groups, as
discussed above, the Sheet Type may have different formats depending on the File Group
and the File Discipline chosen for the first segment of the CAD name. In the discussions
below, all the various formats of Sheet Type are represented by the abbreviation ST. As was
used in the discussions above, the abbreviations for File Discipline and Sequence Number
are DD and NN respectively.
Appendix C shows the characters of the first and middle segment of various file names that
will be assigned by the File Naming Wizard.
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Print (Sheet) Files Naming Convention
PRINT FILES
pDD-STNN_ProjectID.dgn
Where
p=
the file group character that signifies that it is a sheet file which will be
plotted, or used to generate plot files, depending on the software used to
plot.
DD = two-character File Discipline (See Table 1)
ST = Single character abbreviation for plot file Sheet Type (see table on Page
3-8) followed by zero
NN = two-digit Sequence Number. It should match the sheet number where
possible

ProjectID = CCCCCC
Where CCCCCC = Project Code (6 digits)

Reference Files Naming Convention
REFERENCE FILES
tDD-STNN_ProjectID.dgn
Where
t=
the file group character that represents one of these file type designations:
m = signifies that it is a model/design file
d = signifies that the file is a detail reference file
x = signifies that the file is a miscellaneous reference file
DD = two-character File Discipline
ST = two-digit Sheet Type as discussed above
NN = two-digit Sequence Number, which will be either the site or segment
number. If none specified, it will be two zeros.

ProjectID = CCCCCC
Where CCCCCC = Project Code (6 digits)

Support Files Naming Convention
DGN SUPPORT/WORK FILES

sDD-STSN_ProjectID.dgn
Where

s=
DD =
ST =
NN =

is the file group character that signifies that this is a support file and thus
will not be plotted or referenced.
File Discipline
two-digit Sheet Type as discussed above. It is either Q0 or 00 for Support
Files.
two-digit Sequence Number, which will be either the site or segment
number. If none specified, it will be two zeros.

ProjectID = CCCCCC
Where CCCCCC = Project Code (6 digits)
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File Naming Wizard
As stated previously, DDOT has made the decision to follow the CAD standards of MD
SHA. A major component of the CAD standards is the CAD files naming format. This
DDOT CAD manual has provided a few additional abbreviations for Sheet Type that are not
delivered with the Workspace. Except for this, the naming convention has followed the
format developed by SHA, which has allowed DDOT to access and utilize a tool developed
by SHA to promote understanding of and adherence to the new file naming convention. This
tool is called the File Naming Wizard and can be accessed through the IDS Tool Frame in
the DDOT Workspace.

The File Naming Wizard not only constructs the file name but also creates one or multiple
files in numbered sequence using standard seed files. Required fields are labeled in red text:

There are two methods to build a file name using the wizard:
1. Select by Group, Discipline & Sheet Type
2. Select by Description
The File Naming Wizard is described in detail in the MD SHA’s V8 CAD Standards
Training Guide, which has also been included in the files delivered with the DDOT
Workspace. Please refer to V8CADStdTrainingManul.pdf, which is hyperlinked above and is
located in the following sub-directory of the Workspace: ..\Workspace\Documentation. The
DDOT CAD Standards
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hyperlink shown above will work only when viewing the DDOT CAD Standards Manual that
is located in the DDOT Workspace, which can be accessed by selecting CAD USER MANUAL
from the Help pulldown on DDOT Main Menu. Please note that MD SHA's V8 CAD
Standards Training Guide has been included in the Workspace without any modification
since it provides useful information about MicroStation V8 and the SHA developed tools.
However, in instances of discrepancy, the DDOT CAD Standards Manual and the DDOT
Workspace shall govern.

Renaming Files Created with the File Naming Wizard
The File Naming Wizard offers File Discipline and Sheet Type abbreviations that cover a
wide range of file contents for Print (sheet) files. In addition to the ability to define the sheet
number, these abbreviations allow a file name to be unique within a set of sheet files. Thus a
need to rename Print (sheet) files is not anticipated. However, it is likely that users will want
to rename CAD files in the other File Groups.
Though an extensive abbreviation for File Discipline and Sheet Type is delivered with the
new workspace, it is possible for users to find that none of the abbreviations adequately
describe the model reference file they are creating. For example there are no abbreviations
for files that contain only the Geopak generated centerline. In such cases, a broad file
discipline such as HD for highway design shall be used along with a descriptive Sheet Type
such as “CL’ for centerline.
For Detail (Reference) Files, Miscellaneous (Reference) Files and Support Files, the File
Disciplines available to choose from when using the File Naming Wizard are as few as three
or five. These do not cover all possible disciplines that need to be created on a project. Thus a
user may either create a CAD file without using the File Naming Wizard or rename it after it
has been created with the File Naming Wizard. Doing so enables one to select a File
Discipline that is more appropriate for the file content. In addition, utilizing a descriptive
two-character abbreviation for Sheet Type when renaming a file would result in a CAD
name that more explicitly describes the file’s contents. For example, a Support file for which
a descriptive abbreviation has not been delivered with the Workspace is the Geopak
superelevation shape file. In such cases, a broad file discipline such as HD for highway
design shall be used in the first segment, along with a descriptive Sheet Type such as “GS’
for Geopak shape file within the middle segment of the file name.
Renamed CAD files shall adhere to the format and character limits discussed previously in
this chapter.
When an abbreviation for Sheet Type is used outside of those delivered with the Workspace,
and for multi-site or multi segment projects, consultants will provide with each electronic
submittal a file that describes the site number, segment number and Sheet Type convention
for the project. (See The Electronic Data Deliverables chapter in this Manual)
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The table below shows some recommended two-character Sheet Type abbreviations for use
when renaming a file:

File Management
This section discusses the directory structure for the files created for DDOT projects. This
directory format is to be followed whether the project is designed by DDOT personnel or by
consultants.
Though consultants are not required to use this structure at their office, they will
ultimately be responsible for ensuring that project files are submitted on CD at the
completion of a project with the directory structure called for in this CAD
Standards Manual, with the correct reference files attached.
In some instances, DDOT may assign a new task number for supplemental work on an
existing project. In such situations, unless directed by the DDOT project manager, the
original contract number should be utilized for the directory name.
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Directory Structure for DDOT Projects
The recommended directory structure is shown below:
Directory Setup for a Single Site Project
CCCCCC
├───As-Built
├───Details
├───Plot Files
│
├───30%-2005-01-24
│
├───60%-2005-06-19
│
├───90%-2005-10-21
│
└───Final-2005-12-17
├───Ref
├───Sheet Files
│
├───30%-2005-01-24
│
├───60%-2005-06-19
│
├───90%-2005-10-21
│
└───Final-2005-12-17
├───Support
│
├───Calcs-other
│
│
├───30%-2005-01-24
│
│
├───60%-2005-06-19
│
│
├───90%-2005-10-21
│
│
└───Final-2005-12-17
│
├───Calcs-quantiies
│
│
├───30%-2005-01-24
│
│
├───60%-2005-06-19
│
│
├───90%-2005-10-21
│
│
└───Final-2005-12-17
│
├───Geopak
│
│
├───Cogo
│
│
│
├───Criteria
│
│
│
├───Input files
│
│
│
└───Reports
│
│
├───DTM
│
│
│
├───2005-01-24
│
│
│
└───2005-02-27
│
│
├───Misc
│
│
├───Pref
│
│
└───Report
│
└───Misc
├───Survey
│
├───2005-01-15
│
└───2005-02-26
└───Working-temp
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Directory Setup for a Multiple Site Project
CCCCCC
├───As-Built
│
├───Site-11
│
└───Site-12
├───Details
├───plot files
│
├───30%-2005-01-24
│
│
├───Common
│
│
├───Site-11
│
│
└───Site-12
│
├───60%-2005-06-19
│
│
├───Common
│
│
├───Site-11
│
│
└───Site-12
│
├───90%-2005-10-21
│
│
├───Common
│
│
├───Site-11
│
│
└───Site-12
│
└───Final-2005-12-17
│
├───Common
│
├───Site-11
│
└───Site-12
├───Ref
│
├───Common
│
├───Site-11
│
└───Site-12
├───Sheet Files
│
├───30%-2005-01-24
│
│
├───Common
│
│
├───Site-11
│
│
└───Site-12
│
├───60%-2005-06-19
│
│
├───Common
│
│
├───Site-11
│
│
└───Site-12
│
├───90%-2005-10-21
│
│
├───Common
│
│
├───Site-11
│
│
└───Site-12
│
└───Final-2005-12-17
│
├───Common
│
├───Site-11
│
└───Site-12
├───Support
│
├───Calcs-other
│
├───30%-2005-01-24
│
│
│
├───60%-2005-06-19
│
│
├───90%-2005-10-21
│
│
└───Final-2005-12-17
│
├───Calcs-quantiies
│
│
├───30%-2005-01-24
│
│
├───60%-2005-06-19
│
│
├───90%-2005-10-21
│
│
└───Final-2005-12-17
│
├───Geopak
│
│
├───Cogo
│
│
│
├───Criteria
│
│
│
├───Input files
│
│
│
└───Reports
│
│
├───DTM
│
│
│
├───2005-01-24
│
│
│
└───2005-02-27
│
│
├───Misc
│
│
├───Pref
│
│
└───Report
│
└───Misc
├───Survey
│
├───2005-01-15
│
└───2005-02-26
└───Working-temp
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File organization on DDOT Servers
When organizing project files on file servers, please use the following guidelines:
•

Keep all design files belonging to one project together in the proper folder. They can be
referenced easily if they are kept together. They may become disconnected if they are not
kept in the same folder. Files submitted by consultants or others upon project completion
should not be renamed.

•

Update reference files regularly to ensure the most current versions of all design files are
being used. Check the file folder on the server to see if any newer version exists. Also,
keep updated versions of your files on the server so that others can update your files as
their reference files.
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Chapter 4
Design Standards
Introduction
This chapter provides specific details about DDOT’s standard settings and symbology
elements, including standard seed files, color table, level names, fonts, etc. This chapter’s
major sections are listed below:
● Seed Files lists DDOT’s standard seed files for creating new MicroStation V8 files.
● Standard Settings provides details about the settings contained in the standard
seed files. This includes notes about Working Units, Survey Feet, Coordinate
Readout, Drawing Scale (NEW in V8!), Color Tables and DGN Libraries.
● Standard Elements provides information about the feature symbology that has
been developed for the V8 standards, including level names, line weights, line styles
and text styles.

Seed Files
When a new dgn file is created, MicroStation makes a copy of the specified template file.
Template files are known as seed files. To ensure design file setup consistency, the following
standard seed files have been created for use on DDOT projects. These seed files should
always be used as a basis for developing any new design files including cell libraries.
Seed File Name
DDOTModelSeed2D.dgn
DDOTModelSeed3D.dgn

Description
Standard 2D model
Standard 3D model

The following seed file has been developed for use when creating bridge or other detail
sheets in MicroStation 2004.
Seed File Name
DDOTDetailSeed2D.dgn

Description
Self-referenced 2D models at different scales

This seed file consists of multiple V8 Models that are self-referenced at different scales to
facilitate the creation of multiple details at different scales within the same file. (For more
information on working with Multiple Models, refer to the MDSHA V8 CAD Standards
Training Guide in the Documentation directory of the Workspace. As noted previously, in
instances of discrepancy, the DDOT CAD Standards Manual and the DDOT Workspace
shall govern).
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Standard Settings
Working Units
All new V8 design files created for use on DDOT projects must conform to the following
settings, which are incorporated in the seed files (unless otherwise noted):
Global Origin (2D):
Global Origin (3D):
Master Unit (Label):
Sub Unit (Label):

0, 0
0, 0, 0
Survey Feet (’)
Survey Inch (”)

Resolution:
Solids Working Area:

1000 per Survey Foot
>375 Miles

DDOT CAD Standards

Chapter 4-2

2005

Notes on V8 Working Units/Resolution
The MicroStation V8 file format represents a major change in the way that coordinate
data is stored. The 32-bit integer-based design plane has been replaced by a double
precision floating point coordinate system. This has the following practical effects:
1. The V8 design plane is essentially infinite.
2. Positional accuracy, in terms of master units, is essentially unaffected by unit
setup.
3. Unlike Pre-V8 MicroStation, changing the working units does not affect the
size of elements.
In V7, if you draw an element measuring 10 ft, then change the working units from
feet to meters, the element would measure 10 m long. Now with V8, the same change
from feet to meters would result in an element correctly measuring 3.048 m.
While this is an important operational improvement, it also has significant
consequences for the way that DDOT must set up their design files.
International Feet vs. US Survey Feet
By default, a “Foot” in MicroStation actually refers to an International Foot.
However, the state plane coordinate system upon which all DDOT roadway design
projects are based is measured in US Survey Feet.
International Feet: 1 foot = 0.3048000 m
US Survey Feet:

1 foot = 1200/3937 m ≈ 0.3048006 m

The workspace contains a custom units definition file, units.def, which was created by
MDSHA and which defines survey feet and controls the conversion of V7 files to V8.
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Coordinate Readout
The following coordinate readout settings are delivered in the standard seed files:
Coordinates Format:
Coordinates Accuracy:
Angles Format:
Angles Mode:
Angles Accuracy:

Models (2D/3D)
Master Units
0.1234
DD.DDDD
Conventional
0.1234

Details
Working Units
1/64
DD.DDDD
Conventional
0.1234

Drawing Scale
One of the key features of this CAD Standards is the use of a drawing scale which is
displayed along the top of the MicroStation window. (If it does not appear in your window,
select Scale > Display Current Scale from the Main Menu.)

The drawing scale may be changed by selecting the appropriate scale factor from the Main
Menu pulldown. The scale factor is stored with the file.

All scale-dependent drawing elements, i.e. text, cells and linestyles ,have been defined in the
CAD Standards at a unit (1:1) scale. The element is then scaled up or down by the drawing
scale factor when it is selected from a barmenu. This helps maintain consistency of scaledependent drawing features, regardless of the scale being used.
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Programming Note: Before processing any scaling commands, the DDOT Workspace
checks what version of MicroStation is being used (V8.1 or 2004). If it is V8.1, the active
Line Style Scale Factor is used as the default drawing scale. If it is 2004 or later, the Model
Annotation Scale of the active model is used as the default drawing scale. The same Main
Menu > Scale > pull down sets the scale factor for both.

This is a new feature in MicroStation 2004 and has the advantage of being applied at the
Model level (as opposed to the linestyle scale factor which is applied across all models in a
file.)
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Color Table
The standard color table for all DDOT design projects is ClorDDOT.tbl. The color table is
included on the CD. DDOT personnel can also find it on the sever containing the DDOT
Workspace. This color table defines the RGB values for MicroStation colors 0-255. The
monochromatic (black & white) pen tables have been set up for use with this table such that
all colors plot as black, with the exception of those color values defined below.
232
Gray 10%
233
Gray 20%
234
Gray 30% - shading
Gray 40%
Gray 235
Scale 236 Gray 50% - Linework
237
Gray 60%
238
Gray 70%
239
Gray 80%
240
DDOT Logo Red
241
Blue
242
Orange
243
Yellow
Blue
True 244
Color 246
Green shading
247
Green Lines
252
Red shading
253
Red Lines
254 White to block items out
Refer to the chapter on Plotting for more details.
DGN Library
One of the major new changes to V8 is the use of DGN Library files (DGNLIBS) to
maintain and deliver CAD Standards. The DGNLIB provides these standard items to the user
but locks them from being edited, thus helping to maintain Standards. The standard items can
include the following:
•
•
•
•
•

Levels
Level Filters
Text Styles
Dimension Styles
Cells

Only level filters and text styles are maintained in the current DDOT’s standard
DGNLIB. All other standard elements are delivered through other methods. Please
refer to the relevant sections below for more information. Once the CAD Standards
mature through testing and use, more of the above items will likely be put into
DGNLIBS.
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Standard Elements
This section describes MicroStation features and the related CAD Standards that must be
followed to maintain consistency across all design files.
Features
A feature corresponds in a very specific manner to a single type of design information
contained within a file type. A feature defines not only a specific piece of information but
also how it is to appear within the design file. A single file type may contain hundreds of
features, each with its own unique set of attributes.
A comprehensive survey of all features in use by Maryland SHA has been made available to
DDOT in-house personnel and the consulting community without modification for use as
needed. It is maintained in the IDSIM database received from SHA, along with all primary
attributes (level, color, weight, and style, which are also known as symbology) and secondary
attributes (including text size, font, etc).
The most important attributes assigned to a feature are level, color, weight and style. Many
other parameters, such as text font, text size and so on may be defined for a particular feature,
but these extra parameters are not necessarily used for identification purposes. By definition,
two elements belong to the same feature whenever they have the same cell name or level,
color, weight and style, even if other parameters may be different.
Barmenus
As a general rule, the barmenus are used to find the standard symbology (level, color, style
and weight) for any item that is contained in the file. If you need an item and can’t find it in
the barmenus or Feature Search tool, contact the appropriate individuals listed in the
Introduction of this manual. A new feature might need to be incorporated into the next
release of the DDOT CAD Standards.
Levels
Levels are named slots for graphical elements in a file whose display can be turned on or off.
This allows users to have lots of information saved in one file, even if all material does not
need to be used or viewed at the same time. MicroStation V8 allows you to define an
unlimited number of named levels.
Level Names
The V8 level naming convention developed at MDSHA is based on the guidelines set
forth by the National CAD Standards with changes as needed to accommodate a civil
transportation workflow. DDOT has adopted the same level naming convention, and
this is shown below:
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MAJR-MINR-SUBM
Where:

MAJR =
MINR =
SUBM =

4-character Major Group
4-character Minor Group
4-character Sub-Minor Group

As shown in the examples below, most of the levels defined in the seed files have no
need to define the sub-minor group. Thus the majority of level names are in the
format MAJR-MINR.

Level Library for Topographic File

Level Libraries
Level names are managed by attaching level libraries. When a barmenu is selected,
the appropriate level library is attached. The library remains attached if you close and
reopen the file. Note that when level libraries are detached, or if the file is opened
outside of the standard DDOT Workspace, used levels will still appear while unused
levels will not.
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Level libraries have the ability to define level names and descriptions and also by
using the By Level Symbology and Override Symbology for each level. (Note that By
Level symbology has not been adopted in these Standards). All these attributes are
currently maintained for each level library in the IDSIM database. The IDSIM
database can then generate the actual level library files in CSV format, which can be
opened in excel. Therefore, if a level name needs to be modified, all level libraries
using that level can be quickly regenerated. As stated earlier, the MDSHA IDSIM
database has been incorporated in the DDOT Workspace
It is important to mention that levels are not enforced via DGN Libraries for the new
DDOT CAD Standards. Individual level libraries have been created for each file and
can be attached as needed by selecting the appropriate Barmenu from the DDOT
Main Menu. Users also have the option to create new levels as needed and are
encouraged to forward needs and suggestions to the contact person provided in the
Introduction.
Level Filters
Level filters serve two purposes: (1) to limit the number of levels that appear in a
level list and (2) to turn groups of levels on and off when needed. The latter
application is especially useful for controlling level display of attached reference
files.
Standard level filters based on the level
names developed by SHA are delivered as
part of the DDOT Workspace. These
standard filters are maintained in the
levelfilters.dgnlib file. Users may also
create their own filters that are either
temporary or stored in the DGN file
(through the level manager). For more
information, refer to MDSHA’s V8 CAD
Standards Training Guide which is in
the Workspace/Documentation/directory.
(As noted previously, in instances of
discrepancy, the DDOT CAD Standards
Manual and the DDOT Workspace shall
govern).

Line Weights
If plotted line thicknesses are not formally defined, plots tend to have slightly different
appearance depending on the plotter used, the plotting software, driver, pen table, etc. To
avoid this, the DDOT V8 CAD Standards has assigned plotted line thicknesses to
MicroStation weights 0-15 in accordance with industry standard drafting pens.
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MicroStation
Weight
wt = 0
wt = 1
wt = 2
wt = 3
wt = 4
wt = 5
wt = 6
wt = 7
wt = 8
wt = 9
wt = 10
wt = 11
wt = 12
wt = 13
wt = 14
wt = 15

Full Size
Thickness (mm)
0.18
0.25
0.30
0.35
0.50
0.60
0.70
0.80
1.00
1.20
1.40
1.70
2.50
3.80
5.00
6.35

Koh-i-nor
Pen Size
0000
000
00
0
1
2
2.5
3
3.5
4
5
6
8
10
12
14

Half Size
Thickness (mm)
0.09
0.125
0.15
0.175
0.25
0.30
0.35
0.40
0.50
0.60
0.70
0.85
1.25
1.90
2.50
3.175

Standard pen tables for Iplot and PLT files for MicroStation plotting with the above line
thicknesses defined are delivered in the Workspace. (Refer to the Plotting chapter for more
details). In reality, most standard drafting can and should be accomplished using line weights
0-6, as the weights above 6 are extremely thick.
Thin Lines (wt = 0). Thin lines should be used for existing elements such as
baseline/centerline, existing edge of road, existing sidewalks, existing handicap ramps, etc.
These lines should also be used for depicting background object lines, hidden lines, and most
patterning symbols.
Medium Lines (wt = 1). Medium lines should be used for depicting dimension
leaders/witness lines, dimension lines, dimension text, text for notes/callouts, schedule
boxes/charts, text inside schedules, minor object lines, line terminators (arrowheads, dots,
and slashes) and note leader lines.
Medium Thick Lines (wt = 2, 3). Medium thick lines are the default line weight for drawing
most proposed objects including proposed centerline, edge of road, profiles, proposed inlets
and pipes, etc. Medium thick lines should also be used for section titles.
Thick Lines (wt = 4). Thick lines should be used for minor title underlining, text for titles
and object lines requiring special emphasis.
Extra Thick Lines (wt = 6). Extra thick lines should be used sparingly. Extra thick widths
are appropriate for use as elevation grade lines, building footprints or top of grade lines on
section/foundation details.
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Line Styles
The size of those line styles that should be scale-dependent has been “unitized”. This
includes such styles as the Woods Line and any style that contains text. When these styles are
used in a drawing, they must be scaled up or down according to the drawing scale (e.g., times
50 for 50-scale).
This appropriate scale factor is applied automatically when these styles are selected from a
barmenu. However, if they are selected through the usual active attribute interface, they may
appear incorrect in the drawing because of an improperly set scale or an on/off toggle that
was pressed accidentally. When this happens, use the commands under the Main Menu to
apply or remove the scale factor setting. (DDOT Main Menu> Scale > Drawing Scale ON,
and so on.)
Custom Line Styles
Custom line styles are user created line styles which can be used to draw linear elements such
as tree lines and drainage pipes and are truly WYSIWYG (“what-you-see-is-what-you-get”).
The custom line styles shown in Appendix E have been delivered with the DDOT
Workspace. These include the symbology for line elements shown in the new DDOT
Engineering and Design Manual.
Cells
One of the key changes to the use of cells in MicroStation V8 is the ability to place cells at
True Scale. E.g., if a cell is drawn 1 foot wideand placed in a metric drawing, it would
measure 0.3048 m. Similarly, V8 will rectify the size of cells drawn in files with different
units of resolution. This is accomplished through the
True Scale setting.
The V8 cells supplied with the DDOT CAD Standards
have been created with units of resolution to match the
standard seed files (meaning that they will always be
true scale). Nevertheless, it is still recommended that
users keep the True Scale checkbox turned on at all
times just in case.
As with the linestyles, most symbol-type cells (i.e. scale-dependent) have been created at a
unit size for easy placement. For these cells, the active scale should be set to match the
drawing scale (i.e. 1”=50’). When selected from one of the barmenus, the correct active scale
will be applied automatically.
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The standard cells and symbols to be used for the development of roadway plans for DDOT
projects are contained in three cell libraries named DDOT_design.cel, DDOT_survey.cel and
DDOT_traffic.cel. The parameters defined by these cells must be followed on all DDOT
projects.
Numerous cell libraries are supplied with the MDSHA workspace. These libraries are also
included in the DDOT Workspace. Appendix D lists the MDSHA cell libraries supplied with
the Workspace. The cells in these libraries have not been modified in any way. Users should
use the MDSHA supplied cell libraries only if a cell for that feature does not exist in the
DDOT cell library.
Fonts
The CAD Standards have a single resource file (DDOTfonts.rsc) that contains all fonts.
In order to achieve more consistent plan sets, the following standard fonts are recommended
for use:
1 – Working:

Proportional font

10/43 – Leroy:

Filled font

3 – Engineering:

Mono-spaced font

42 – font042:

Block font

2 – Fancy:

Serifed font

23 - Slanted

Slanted font for describing all existing features

Use of these fonts is being encouraged through their implementation as Text Styles.
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Consultants who require additional fonts for company names or logos may use them as
required. However, it should be recognized that in order for electronically submitted plans to
display properly, the resource file for any added fonts will need to be submitted as well.
Text Styles
MicroStation V8 has introduced a new feature to facilitate the placement of text – Text
Styles. Standard text styles can be created with preset font, text height, text width, etc., for
quick and easy placement. The DDOT Workspace takes advantage of Text Styles in the
following ways:
One of the primary advantages of Text Styles, aside from maintaining consistent appearance
of text, is the ability to propagate the drawing scale to the size of the text. As long as the
Drawing Scale has been properly set from the Main Menu, the size of the text will match. In
MicroStation 2004, this is achieved by enabling the Model Annotation Scale Lock.
•

Sample text styles have been placed in the seed files. Note that these are
currently not locked for editing by a DGNLIB file.

•

Text Styles are automatically scaled by the active Drawing Scale as follows:
MS V8.1 – changing the drawing scale via the Main barmenu triggers
a macro that scales the text size of all text styles in the file by an
appropriate factor.
MS 2004 – text styles are maintained at unit size (1”=1’) but will be
scaled at the time of placement if the Model Annotation Scale Lock is
enabled.
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NOTE: In V8.1, if a user changes the drawing scale of a file that already contains text, the
macro will break the association of the text with the text style used to create it. However, this
will not change the appearance of text.
In 2004, the user will be asked if the drawing scale should be applied to existing text… the
recommended response is NO.
Importing Standard Text Styles
If a file was not created based on a standard seed file, it will not contain proper text
style definitions. (This is common for files converted to V8 from an earlier version.)
Similarly, if a file was created in V8.1 and later worked on in 2004, there will likely
be a disconnect with text size (owing to use of the Model Annotation Scale Factor).
To address both of these issues, there is a command on the Main Menu that will
import the standard text styles, scaling them as appropriate. (Main > DDOT Toolbox
> Import DDOT Textstyles) Be careful, however, because this action will delete any
custom text styles you may have created.
Dimension Styles
Dimension Styles are another new MS V8 item. A dimension is a label that shows the linear,
radial or angular measurement of an element. A dimension style is a saved set of
dimensioning settings. Dimension settings can be stored in either a DGN file or a DGN
library. Dimension styles have been created for: Architectural, Structural, Civil, Detail and
Survey. These dimension styles are maintained in the seed files delivered with the CAD
standards rather than in the DGNLIB. As with the Text Styles, missing Dimension Styles
may be imported to a file from the Main Menu (Main > DDOT Toolbox > Import DDOT
Dimension Styles). Once these styles have been refined through use, they may be added to
the DGNLIB file.

DDOT CAD Standards

Chapter 4-14

2005

Notes 

DDOT CAD Standards

Chapter 4-15

2005

Chapter 5
Drafting Guidelines
Introduction
This chapter provides basic drafting guidelines and procedures when creating contract
documents. Some of the information is specific to use of MicroStation V8, while other
information is more universal. It is hoped that the information contained in the chapter will
prove helpful to drafters both new and experienced.
This chapter’s major sections are listed below:
• DDOT Border File discusses the use of the standard D-size border file developed for
creation of contract documents at DDOT.
• Reference Files contains basic information about attaching reference files in
MicroStation V8, and provides recommendations for using the new settings.
• Text Placement: Model vs. Print Files discusses the proper placement of text in
design files.

DDOT Border File
In order to promote a standard title block, a single border file has been developed for all
disciplines across DDOT, which should be used for all files except title sheets. This file is
located in the Workspace/ Standards/DDOT_V8_01/dgn/ directory and is named
DDOT_Border.dgn. For title sheets, the file named DDOT_Titlesheet.dgn must be used.
This file is also located in the same directory.
The border file has individual saved views created to deliver discipline-specific settings.
When the border file is attached to the plan sheet as a reference file, the appropriate saved
view should be selected. The borders and standard sheets provided in the Workspace are
drawn to the conventional 1" = 1' scale and should be scaled up or down accordingly when
attached. Please refer to MDSHA’s V8 CAD Standards Training Guide for more
information. (As noted previously, in instances of discrepancy, the DDOT CAD Standards
Manual and the DDOT Workspace shall govern).

Reference Files
Many interface changes have been made to the way in which reference files are attached. The
following recommendations are provided to help you understand the new V8 settings.
Save Relative Path
DDOT recommends all users enable this check box. It remembers the directory location of
the reference file relative to the directory of the active file, thereby promoting portability of
the project working directory. This setting will not interfere with the MS_RFDIR variable.
DDOT CAD Standards
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Note that this setting has essentially replaced the
Save Full Path option of earlier versions, which is
no longer an option. Rather, MicroStation V8
searches for reference file attachments in the
following manner:
1.
2.
3.
4.

active directory
relative path directory
MS_RFDIR directory
full path directory

Coincident-World
This setting adjusts reference files with different
Global Origins. The Workspace is set up by default
to attach coincident-world orientation. It is
recommended that this option always be enabled.

True Scale
This setting adjusts reference files with different Units
of Resolution. As with Coincident-World, it is
recommended that this option always be enabled.
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3D and 2D Design Files
MicroStation V8 now allows 3D files to be referenced into 2D files! This means that under
no circumstances should topo files, grading files or other 3D files be “squashed” (exported)
to 2D to accommodate referencing into a 2D plan sheet.
Such practice, while common to the V7 workflow, creates the undesirable issue of having
multiple versions of the same file in production. If the information in the file needs to
change, there is a likelihood that the changes will not be made uniformly to both. Sooner or
later, confusion arises as to which copy of the file reflects the most up-to-date information.
Repeat: there is no longer a need to convert 3D files to 2D. Don’t do it! If the need arises, set
your active depth to zero and activate the Depth Lock.

Text Placement: Model vs. Print Files
Annotation text belongs in the Print file whenever possible. However there are instances
when text must be placed in the Model file. This usually occurs for items that can be
annotated across the entire job, (usually with InRoads or GEOPAK), such as topo text or
alignment stationing.
The advantage of placing text items in the Model file is that as the design is refined, the
changes can be made globally to the entire project. The disadvantage is that text in a given
Model file often overlaps with text in another Model file, both of which are referenced into
the same plan sheet. When this occurs, the recommended workflow is to resolve the text
conflict in the Print file, NOT in the Model file. As follows:
1. Identify the text item that is least likely to change (e.g. topo text labels)
2. Copy all the text from the level on which the conflicting text is located into
the Print file (i.e. plan sheet).
3. Turn off the Model file level containing the conflicting text.
4. Resolve the text conflict in the Print file.
Note that all text in a given model file should be at the same scale. 1”=20’ is used for most
projects, and topo is generated at that scale unless a specific request is made in advance.
Sometimes, a designer requires the same annotation for different scales (e.g. geometry sheet
stationing, wetland plates). Given the ability in MicroStation 2004 to set the Annotation
Scale at the model level, designers are encouraged to create a separate model within the same
DGN file that is reserved solely for the text at the alternate scale.
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Chapter 6
Electronic Data Deliverables
Introduction
This chapter discusses the DDOT Standards for Electronic Submission at the end of design
and construction projects.
If the contract for a project requires electronic deliverables in addition to hard-copy
deliverables, the guidelines in this chapter shall be followed. It is critical that the hard copy
and electronic copy dates match.

MicroStation Files
All drafting for DDOT projects should be done using the version of MicroStation currently in
use at DDOT. If directed otherwise by the DDOT project manager, more current versions of
the software shall be allowed for use on a project. However, older versions of either
MicroStation or Geopak than are in current use at DDOT are not allowed. It is the
consultant’s responsibility to make sure they are using the proper version.
The file naming convention for the MicroStation files shall be as specified in the CAD Files
Management and File Naming Conventions (Chapter 3). All MicroStation files required to
recreate the project including plotted sheets and reference files shall be submitted as well as
any additional resource files used that are not part of the DDOT Workspace, i.e. fonts used to
create a consultant’s name or logo.

Roadway Design Files
All roadway design should be done using Geopak. The Geopak files to be submitted include,
but are not limited to, the following:
•
•
•
•
•
•
•
•
•
•
•
•

.gpk file
.prj files
cogo input files in ASCII format. These input files could be for creating horizontal
alignments, vertical alignments, ROW lines, etc
COGO output files in ASCII format
Tin files required to create DTM surface files of existing ground, final design surface, as
well as intermediate and as built surfaces if called for by the contract
criteria files for creating superelevation shapes
criteria files for generating cross-sections
criteria files for creating cross-section layout file
criteria files for cross-section annotation
criteria files for calculating earthwork
criteria files for quantity calculations
Resource files, i.e. .ddb file, used for drawing elements to aid in quantity calculations

DDOT CAD Standards

Chapter 6-1

2005

Other files should be submitted in ASCII, Microsoft Word or Excel format. These include
Spreadsheet Data such as Quantities, Summary Sheets and Index of Files.

Readme.txt
In order to facilitate future data retrieval, all electronic data submittals should be
accompanied by an electronic file titled readme.txt. This file will contain a list of all the
electronic files that are part of the submittal and will indicate the version of MicroStation and
Geopak used for the project.
The DDOT Workspace and accompanying electronic files, such as seed files and cell
libraries, will be provided by DDOT on a CD. However, these files are subject to change
during a project’s life cycle, and consultants may periodically receive new data files. Thus it
is important to include a note in the readme.txt file that shows the release date of the DDOT
provided data.
For multi-site or multi segment projects, consultants will include in the read me.txt file an
explanation of the site number or segment number convention for the project.
A hard copy of the readme.txt file shall be submitted with each CD containing electronic
submittals.
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Chapter 7
Plotting
Introduction
One of the primary goals of the CAD Standards effort is to enable the creation of uniform
plots sets. Often, plots cannot be reproduced from a set of CAD files because the current
owner is unaware of how the original plots were created or does not have access to the pen
tables/plot drivers that were used.
This chapter describes the plotting procedures to be used at DDOT. Plotting refers to using a
printer or large-format plotter to print a hard copy on paper from CAD drawings. Plots can be
created with either I-PLOT or Standard MicroStation plotting. Resources provided in the V8
Standards for both methods are described in this chapter. MicroStation plotting is commonly
used at DDOT. If DDOT decides to use I-Plot in the future, changing from one method to the
other should not result in different outputs. In order to provide a Standard for baseline
plotting, plot drivers were created for standard MicroStation plotting, including both mono
and full-color plans.
This chapter has five sections:
Plotting Standards formalizes the plotting weights and line styles that should be
used when producing DDOT plans from CAD files.
Standard MicroStation Plotting covers using pen tables, identifying the plotting
area, verifying the plotter, setting the scale and more.
Generating Images from MicroStation Files describes some methods for
generating image files from MicroStation.

Plotting Standards
DDOT is attempting for the first time to standardize plotting characteristics for contract
documents. These parameters include the plotted line thickness (in inches) for standard
MicroStation weights 0-15 and the stroke lengths (in inches) for standard MicroStation line
styles 1-7. The goal is to establish a baseline by which any plots can be duplicated using any
plotting method. The standard plot drivers and IPLOT pen tables included in the Workspace
should serve as a basis for achieving this result.
Large-format Plotters: A roll-feed machine (typically 36-inch rolls) for the production of
larger drawings should be inkjet or thermal. These print a standard-size 34 x 22-inch sheet
from MicroStation for all construction documents and plans. Other sizes are used for large
wall-display boards.
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B/W
Color

IPLOT pen table

MicroStation plot driver

FullMono.pen
FullColor.pen

FullMono.plt
FullColor.plt

Standard-format LaserJet and Inkjet Printers: Half-size plans are often required (11x 17inch, tabloid). This is also used in the production of plats, smaller drawings and related
documents.

B/W
Color

IPLOT pen table

MicroStation plot driver

HalfMono.pen
HalfColor.pen

HalfMono.plt
HalfColor.plt

Line Widths
The DDOT V8 CAD Standards establishes plotted line thicknesses. If this is not defined, the
line thicknesses that appear on plots will be dictated by the plotter. DDOT has attempted to
correct this by hard coding the plotted line thicknesses into the new MicroStation plot
drivers. This is also done for IPLOT pentables for the convenience of consulting firms which
use IPLOT. Line weights 0-15 have been re-defined to correspond with the thicknesses of
traditional drafting pens, as follows:
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MicroStation
Weight
wt = 0
wt = 1
wt = 2
wt = 3
wt = 4
wt = 5
wt = 6
wt = 7
wt = 8
wt = 9
wt = 10
wt = 11
wt = 12
wt = 13
wt = 14
wt = 15

Full Size
Thickness (mm)
0.18
0.25
0.30
0.35
0.50
0.60
0.70
0.80
1.00
1.20
1.40
1.70
2.50
3.80
5.00
6.35

Koh-i-nor
Pen Size
0000
000
00
0
1
2
2.5
3
3.5
4
5
6
8
10
12
14

Half Size
Thickness (mm)
0.09
0.125
0.15
0.175
0.25
0.30
0.35
0.40
0.50
0.60
0.70
0.85
1.25
1.90
2.50
3.175

Color Table
The standard color table for all DDOT design projects is ClorDDOT.tbl. This color table
defines the RGB values for the MicroStation colors 0-255. The monochromatic (black &
white) pen tables have been set up for use with this table such that all colors plot as black,
with the exception of those color values defined below.
232
Gray 10%
233
Gray 20%
234
Gray 30% - shading
Gray 40%
Gray 235
Scale 236 Gray 50% - Linework
237
Gray 60%
238
Gray 70%
239
Gray 80%
240
DDOT Logo Red
241
Blue
242
Orange
243
Yellow
Blue
True 244
Color 246
Green Shading
247
Green Lines
252
Red Shading
253
Red Lines
254 White to block items out
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Standard MicroStation Plotting
There are three steps to generating prints or plots of your drawings using MicroStation’s
standard plotting capabilities:
•

Identify the portion of the design file to be plotted.

•

Select the appropriate plotting device.

•

Transmit the drawing to the plotter.
Identify Plotting Area:
The area you wish to plot can be identified by one of two methods: Plot by View or Plot by
Fence, the most common. Follow these steps to identify your plot area:
1. Place a fence or arrange within a view, the portion of the drawing you wish to
plot. If you need to plot to a scale, you must place a fence around the sheet border.
2. Start the plot process by keying in PLOT or PRINT in the key-in window.
Alternatively, you may press the accelerator key CTRL, + the P key.
Alternatively, you may select the Print/Plot command from the File pull-down
menu.
3. Examine the status line on the Plot dialog box to ensure that “Fence (View n)”
displays if you intend to plot contents within the fence you have placed.
Otherwise, it will display “View n”.
Plot Drivers:
Plot drivers determine how the MicroStation elements are translated to the printer, including
exact colors and the thickness of various line weights. After identifying the plotting area, you
need to select a plotter driver. The following drivers are delivered in the V8 Standards for
various uses.
FullMono.PLT – For plan sheet production. This will plot all colors, regardless of how they
are displayed, as black, except for the following:
Color #
232
233
234
235
236
237
238
239
240
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Plotted Color

LightGray 10%
Gray 20%
Gray 30% - shading
Gray 40%
Medium Gray 50%
Gray 60%
Gray 70%
Dark Gray 80%
DDOT Logo Red

Color #
241
242
243
244
246
247
252
253
254
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Blue
Orange
Yellow
Blue
Light Green
Green
Light Red
Red
White
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HalfMono.PLT – Identical to FullMono.PLT. However, line weights are scaled for 11 x 17inch prints.
FullColor.PLT – For full-sized sheets. Colors print as they appear on screen.
HalfColor.PLT – Identical to FullColor.PLT. However, line weights are scaled for 11 x 17inch prints.
The active driver name displays in the Plot dialog box next to the icons. You will normally
use “printer.plt” for your plots. This driver maps to the Windows system printer driver. If
you want to change the plotter driver so that you do not have to use the Windows system
printer, follow these steps:
1. Click the Plotter Driver button, the icon farthest to the right.
2. From the Select Plotter Driver File dialog box, select the appropriate plotter
driver. By doing so , you are indirectly selecting the size of the plot you are going
to generate.
Specify Plot Size:
With the correct plotter selected, the next step is to verify the size of the plot. This is done via
the Page Setup icon on the plot dialog box. The Page Size field allows you to select your
plot output size.
Set Scale Factor:
You can set the scale factor in two different ways:
1. Key in the master units to plotter units directly.
2. Key in the size as a percentage of normal and let MicroStation calculate the scale.
Keep in mind that this is the ratio of design file master units to plotting units. This means
that if you are plotting a drawing created using feet, and the scale is 4 feet per inch, the result
is a final ratio of 48:1 (48 inches, in the drawing, to 1 inch of paper).
The scale factor and the four fields in the Margins section of the Plot Layout dialog box are
interlinked. When you change one, the other values are automatically updated to reflect the
change.
Maximize Plot (Optional):
Sometimes you may want to plot the contents of a fence or a view at the maximum size of
the plotter’s chosen paper size. You can achieve this by enabling the Maximize check box.
This results in the chosen drawing area being plotted to the extents of the plotter’s page size.
This is also the default condition when you first enter the Plot dialog box.
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Center Plot (Optional):
The Center to Page check box shifts the entire plotted area to the center of the chosen page
size. In many cases, the plot area you have selected doesn’t use the same height-to-width
ratio as the page size. Using the Center to Page option makes the final plot look more like a
finished drawing and may eliminate the need to manually trim the paper plot after printing.
Rotate 90:
The Rotate 90 Degrees option on the Page Setup dialog box is similar to a
portrait/landscape option on printer drivers. Your design may fit more economically on a
sheet of paper if you rotate it 90 degrees.
Plot Options:
The Plot Options icon brings up a list of additional options for plotting your drawing. Some
of the options can be dimmed because they are displayed for information only. If you want to
modify any of the plot options, you will need to do so in the View Attribute dialog box in
the Settings menu.
Preview Your Drawing Plot:
Before actually generating your plot, you have the option to preview its appearance right in
the Plot window. This is done via the Preview Refresh icon. This is very helpful for seeing
the effect of line weight definitions within the plot driver file and other key data.
Transmit Drawing to Plotter:
Follow these two steps to create the plot:
1. Click on the Plot icon, which launches the plot if “printer.plt” is the driver being
used.
2. If a driver other than “printer.plt” is selected, you are prompted to give the file
name into which the plot data will be placed. The default extension of this file is
.000. MicroStation will then create a plot instruction data file for processing by
the plotter later.
The most common method for transferring plot data to the plotter is to use MicroStation’s
PlotFile batch program. From the DOS prompt, key in PLOTFILE filename and hit Enter.
While transmitting the plot file to the plotter, the computer will not be available for
other work.

Generating Images from MicroStation Files
Typically, drawings are printed and reviewed. Creating and sending an electronic image of
the drawing provides the ability to share the information between users economically by
saving money on paper and ink and allows for faster distribution.
Depending on the purpose, you may want to generate the entire project, a drawing sheet or a
close-up view to focus on an issue. Some applications include:
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•

Creating an archive of construction documents that can be printed from any
image software

•

E-mailing sheets or views for fast review and action

•

Inserting pictures of drawings into other documents (Word, PowerPoint,
CorelDraw, PhotoShop and so on)

•

Renderings/Displays

Three ways to generate images from CAD files will be discussed.
•

Using the HD BW Image Printer (I-Plot Monochrome Raster Offline Driver)

•

Using a customized Image Plot Driver (PLT)

•

Using Utilities>Image>Save

Using the HD BW Image Printer (I-Plot Monochrome Raster Offline Driver)
The HD BW Image Printer creates a TIF file and is the preferred solution to generate fullsize black-and-white images that look just like plan sheets. The process is identical to
plotting, except the printer is selected as the HD BW IMAGE on HDDPLOTPC. If you
were to plot the images that the driver generates by using any standard image editing
program on the same size paper, it will closely match the prints that were generated,
including pen tables and any effects applied through I-PLOT or a MicroStation .PLT file.
You can actually print from any windows software to HD BW Image, such as Excel, Word
or PowerPoint.
The resolution is high enough for full-size plots with clear text and symbols, and the file size
is small enough to run the files through an Internet Web viewer or to put hundreds of plan
sheet images on a single compact disc. The small file size for such a high resolution is
accomplished because the driver generates a Monochrome (Black and White only) image.
However, it goes further than strictly turning all colors into solid black; the driver transforms
shades of gray or colors into finely speckled black. From a distance, the speckles appear
gray.
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A printed plot document using an HD BW Image Printer

The process is identical to plotting, except the printer is selected as the HD BW IMAGE on
HDDPLOTPC.
When using MicroStation’s standard File > Print command, select the following:

Printing a fence using a Windows printer
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Selecting the appropriate printer

When using MicroStation’s add-on I-PLOT printing software, select the following:

DDOT CAD Standards

Chapter 7-9

2005

You can also use the InterPlot Organizer to print out an entire job. In any case, the images
will be created in the folder called HD BW Image.
IMPORTANT: Once the files are generated at this location, they should be copied to the
appropriate project directory. ONCE A WEEK, THE FILES IN THIS FOLDER WILL
BE AUTOMATICALLY DELETED WITH NO PRIOR NOTICE.
In addition to the folder where images are printed out, the Administrator implements several
important settings on the plot server which are outlined on the following pages.
Admin Settings for I-Plot Monochrome Raster Offline Driver
HD BW Image is the I-Plot Monochrome Raster Offline Driver printer. While
numerous settings exist, here we explain:
•

Setting a File-Naming Pattern

•

Creating a custom-size plan sheet

All the settings are accessed through the Control Panel>Printers.

Right-click on the correct Printer, and select Properties.
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Setting a File-Naming Pattern
Make sure you are on the Ports tab, as shown below.

Highlight HDImage and select Configure Port.

The menu above shows the current directory where TIFs will be stored as well as the
Naming Pattern for files that are generated through the printer, which is to use the
DOCROOT, or filename without extension and add the .tif extension at the end.
Select Pattern Setup to change these settings.
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You can use any combination of variable names to create your pattern. Use the Help
tab for explanations of the variables. You may also type characters; in the case above,
the .TIF was added so that the file automatically receives the correct file extension.
Setting a Custom Page Size
Make sure you are on the Device Settings tab of the printer Properties window as
shown below.

Select InterPlot Device Attributes, and you can set up a custom size using the menu
below.
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Using a Customized Image Plot Driver (PLT)
Through MicroStation’s Standard Print dialog box, the user selects a .PLT file. Most consider
.PLT files as a way to select the printer, but you can also select drivers that produce images.
The TIFF.PLT that was delivered with MicroStation was customized in three forms, all of
which plot in landscape view and in full color.
These generate plots with similar line thickness and appearance as a normal plot, including
white background.
When using MicroStation’s standard File>Print, select the following:
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Depending on the application, select one of the following:
TIFF_22by34INCH.PLT – Produces high-resolution images that contain 200 dpi when
printed at 22 x 34 inches. File size is high – around 2250 KB.
TIFF_11by17INCH.PLT – Produces high-resolution images that contain 200 dpi when
printed at 11 x 17 inches. File size is moderate – around 800 KB.
TIFF_PPT.PLT – Produces images that are 1024 x 768 pixels in size, which is appropriate
for PowerPoint presentations, inserting smaller images in documents or e-mails. File size is
low – around 140 KB.
Using Utilities>Image>Save
This is useful primarily in 3D renderings as the various rendering shadings (e.g., ray trace)
are available. It has been applied to 2D drawings using wireframe shading to generate
plotlike images.
The results will be WYSIWYG, except that you can generate an image of as high a
resolution as you desire.
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Appendix A
Glossary

This glossary was developed to ensure that terms were consistent in this manual and with
DDOT practices, recognizing that meanings may differ when used outside the context of
these Standards.

Term or Abbreviation

Definition

Attribute
Addendum

Property, such as color or style, of an element or entity.
Making a change to a construction project. See
Redlining.
Computer-aided design software that runs on personal
computers.
The “Barmenu” is a freely available and customized
MicroStation Development Language application. The
executable file extension is *.ma.
It sets symbology and initiates standard commands for
drawing elements, also known as features. The features
are arranged in a logical hierarchy on the
Barmenu. Different File Disciplines and Purposes will
have their own Barmenus, and each Barmenu should
contain only those features belonging in a specific file.
Borders. This term was used in the hand-drafting days.
Computer Aided Design and Drafting
See CAD, the more commonly used abbreviation
A cell description convention consisting of two numbers
enclosed in parentheses which permits programmers to
create and write utilities which count cells and tabulate
them based on more than one thousand Category Code
Numbers.
Consulting Engineers Council
A complex element composed of a group of primitive or
other complex elements that is stored in a cell library for
repeated placement.
A file used to store cells. To access cells in a cell library,
the library must be attached to the active DGN file,

AutoCAD
Barmenu

Base linens
CAD
CADD
Category Code Number

CEC
Cell

Cell Library
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Term or Abbreviation
Check-In
Check-Out
Clip
Clip/Clipping Boundary

Clip Mask

CSV File

Design Rules
Detail
Dimension Styles (Attributes)

Discipline-specific Seed File

Display

Drawing Scale

DTM
DWG

DDOT CAD Standards

Definition
except if the Cell Selector dialog box is used.
Process of restoring a checked-out file to the server.
Process of copying a file from the server for exclusive.
editing rights
To divide an area, elements or portions of elements in a
design for manipulation or display.
A boundary (established with a fence or from a named
view) that separates the part of a reference that is
displayed from the part that is hidden.
Used with the Raster Manager or Reference tools, a clip
mask allows you to clip out a portion of the image.
Masking can be used, for example, to clear an area for
text display.
Comma-separated values file: The CSV file format is an
interchange format for tabular data, such as the contents
of a flat file database or a table in a relational database.
In this text file format, the first line contains the database
field (column) names separated by commas. Each
successive line corresponds to a database record (row).
On each such line, commas separate the subject record's
field values.
Component interactions that provide flags for the
designer when a design does not meet DDOT design
criteria.
A file type used to sketch identifying construction or
design details.
Three new ones have been created: Civil, Structural and
COGO, the coordinate geometry programming language.
These are the settings for all components of dimension
elements, including text (color, weight, font, height and
width), lines (color, style, weight and alternates), and
level.
A template used to create CAD drawings. It’s a blank
design file with appropriate DDOT-specific working
units and other settings to create custom files for each
Division’s use.
Final product of CAD files intended for plotting,
including any plan, profile and cross section sheets,
schedules, wall displays and other files.
Drawing scale helps to maintain consistency of scaledependent drawing features, regardless of the scale used,
including text, line styles and cells.
Digital Terrain Model
A file extension denoting drawing files.
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Term or Abbreviation

Definition

DGN
DGNLIB
Export
Feature

A design file in MicroStation/J and version 7.
In MicroStation V8, the Design File Library.
To send data from an application to another source.
Single type of design information within a file type.
Uniquely identifiable by its level, color, weight, and
style.
Office or Division that is designated as an owner of a
CAD feature and defines its attributes.
Office or Division that should be consulted by a Feature
Owner when defining its attributes.
An engineer or designer who uses a feature when
creating a drawing.
Broadly describes the discipline of information appearing
within a particular design file in terms of whether it is
highway design, survey, drainage design, signage or
pavement marking.
Groups under which file types are categorized
Describes the general purpose that the individual files
serve as part of the larger CAD production workflow:
Model, Existing, Proposed, Detail, Print and DGN
Support.
A CAD file containing a specific type of information,
namely, Model, Display or Detail.
A polygonal boundary that designates multiple elements
for simultaneous manipulation using fence tools.
In the V8 Standards, a Horizontal Design file
encompassing the horizontal location of the road
centerline, edges, sidewalks, cut/fill and other design
elements. It replaces an HA file in V7.
Integrated Design System
Integrated Design System Information Manager. It
maintains the list of CAD features with their unique
symbology (color, level, weight and so on). IDSIM
tracks changes as they are made to the Standards,
allowing for version control (version 1.0, version 2.0,
etc.). IDSIM facilitates adherence to the standards by
allowing CAD Managers to design, modify and generate
*.MDF files that drive the Barmenu.
A group of MicroStation add-ons. It is not a single item
but a collection of programs.
Interactive Graphics Design System: the software that
ran on Intergraph VAX-based CAD systems
Civil engineering add-on programs used with
MicroStation.

Feature Owner
Feature Stakeholder
Feature User
File Discipline

File Group
File Group

File Type
Fence
HD File

IDS
IDSIM

Tool Box
IGDS
InRoads and GEOPAK
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Term or Abbreviation

Definition

I-PLOT

A MicroStation add-on that allows for greater usability in
plotting.
Bentley’s digital plotting management program.
MicroStation plot organizer that allows you to print out
an entire job.
An improved version of I-PLOT that automatically
calculates the other value to maintain the aspect ratio of
the plot.
A file containing plot parameters and other data. An
IPARM file must be created before executing a plot.
An instruction entered into the Key-in window to control
MicroStation. Most key-ins have graphical user interface
(GUI) control equivalents. To “key in” means to enter
this information manually.
Named slots for information in a file. MicroStation V8
allows the user to create an unlimited number of levels.
Their display can toggle on or off, allowing users to have
lots of information saved in one file, even if the material
does not need to be used or viewed at the same time.
Level filters limit the number of levels that appear in a
level list. They also turn groups of levels on and off
when needed.
A part of the symbology of an element, for example,
whether a line is solid, continuous dashes, dots and
dashes and so on. Each element can have its own line
style or can be defined by separate symbology. You can
create custom line styles.
A file that creates or defines other files. It’s commonly
used when creating directories.
MicroStation Development Language. The extension of
the executable file is .MA.
File extension for a MicroStation Database File
Maryland State Highway Administration/District
Department of Transportation
Version 8 of the MicroStation CAD software
Version 7 of the MicroStation CAD software
Coordinately accurate drawings, usually in 3D format
Files critical to CAD design but are not themselves CAD
files
Same as Detail Sheets. They show all the design work for
a project.
An instrument that graphs the final output of a
MicroStation drawing
A customized image plot driver/a plot file extension.

InterPlot
InterPlot Organizer
I-PLOT Plus

IPARM
Key-in/key in

Levels

Level Filters

Line Style

Metafile
MDL
.MDF
MDSHA/DDOT
MicroStation V8
MicroStation J
Model Files
Non-DGN Support
Plan Sheets
Plotter
PLT/.PLT
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Term or Abbreviation

Definition

Plotting

Plotting refers to using a printer or large-format plotter to
print a hard copy on paper from CAD drawings.
A MicroStation batch program that transfers plot data to
the plotter.
Files where all text, such as tables and construction
schedules, should be placed that cannot be directly
referenced from a Model file.
An EIM system that manages file version control and
tracking.
The process of making changes to a construction site,
which involves a great deal of coordination and
paperwork.
A design file attached to an active design file. Elements
in a reference file cannot be manipulated.
Refers to software license.
A settings file is an import or export file that stores all
settings for a particular conversion as they were when the
settings file was created or last saved. Also, a type of
module data (“.stg” files) that specifies active settings
and drawing tool selections; used with the Select Settings
window. The Settings Manager oversees all this.
A large design file printed in hard copy, similar to
architectural plans.
The last known or current status of an application or
process.
A designated directory for storing files
When two different types of design information share the
same level, color, weight and style but differ by some
other parameters (e.g., text size or cell name).
Refers to level, color, style and weight of a drawing
object.
New to V8, text styles are used to apply standard text
attributes to newly created text. The active Text Style
applies to placed text, annotations, tags and other
element types that use text.
Tagged Image File Format
A tool box that has smaller tool boxes.
Topography. Files containing maps and surveying
information.
File storage spaces for engineering documents.
A display mode in which surfaces are displayed as their
outlines, and elements behind surfaces are displayed as
though the surfaces did not exist.
Workspace with the same measurements in a file

PlotFile
Print Files

ProjectWise
Redlining

Reference File
Seat
Settings Manager

Sheet file
State
Storage Area
Sub-feature

Symbology
Text Styles

.TIF or .TIFF
Tool Frames
Topo Files
Vault
Wireframe

Work Area
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Term or Abbreviation

Definition

Working files

Nonstandard files used for engineering, calculations and
measurements by the designer. They are scrap paper and
a backup of the person’s work.
A defined sequence of procedures.
An operating mode of MicroStation, such as DGN, DWG
and V7 workmodes.
A custom MicroStation environment or configuration
The menu DDOT employees use to set up individual
MicroStation workspace.
Real-world units to which the design plane is configured
to.
The settings that designate the working units and
working resolution.

Workflow
Workmode
Workspace
Workspace Preferences Menu
Working Units
Working Unit Settings
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Appendix B
MicroStation & Other Application Software

MicroStation V8
MicroStation V8 is the current version of Bentley’s CAD software adopted by DDOT. The
upgrade from MicroStation J to MicroStation V8 marks a new milestone in CAD
technologies, introducing several new features:
•

File format change;

•

Changes to clipping plot files for easier manipulation;

•

Unlimited levels associated with a file.

DDOT’s V8 standards are designed to work with MicroStation Version 08.01.02.15 or later.

Civil Engineering Applications
DDOT uses a civil design software application called GEOPAK on top of its CAD
drawings.

GIS Attributes
GIS Attribute flags are necessary to create the needed GIS layers from the CAD File. These
features must be accommodated. Such features include traffic signals, storm drains and
culverts.
Custom software to support workflows will make it easier to work together. Numerous
custom utilities, such as Barmenus, Toolbox and several others are delivered with the
Standards. These utilities simplify adherence to Standards while promoting consistency and
efficiency.
These tools automate the process of creating and drafting project plans. They ensure that the
plotted final result will be consistent and legible. By developing the files consistently, we are
imparting “intelligence” into the files. In other words, the various items in the file are coded
consistently with a knowledge base that tells us what the items are representing. This
intelligence is the foundation for further application development that relies on scanning the
file for the features based on the consistent end product. Some examples are below:
5) Estimating: Adherence to CAD Standards feature tables accommodates
developing Engineering Estimates from the files, as each feature can be
identified and quantified by its unique symbology.
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6) Specifications/IFB Generation: CAD Standards accommodate developing an
Invitation for Bids or Specifications Book from features used in the design
files. For example, if CAD features are designed consistently throughout the
project plans, each is assigned a number in a central repository, and users
select only what they need.
7) Design Rules: CAD Standards accommodate Design Rules. Design Rules are
the component interactions that provide flags for the designer when a design
does not meet DDOT design criteria. For example, during the placement of a
signal pole, a flag appears indicating that it is too close to the curb line and
does not meet DDOT criteria. Therefore, it must be placed in a new location.

Notes 

DDOT CAD Standards

Appendix B-2

2005

Appendix C
File Names as Defined by File Naming Wizard

As discussed in Chapter 3, file names will have the format gDD-TTSS_ProjectID.dgn
Where:

ProjectID

g
DD
TT
SS
=

=
one-character File Group
=
two-character File Discipline
=
two-character Sheet Type
=
two-character Sequence Number
six digit project ID

Shown below are the names that the File Naming Wizard will assign to various file contents.
The middle segment of a file name is separated by a “-“ (dash) from the first segment and by
a “_” (an underscore) from the third segment of a file name. In the tables below, if there are
less than four characters in the middle segment of the file name, please note that the name
would actually have zeros to bring the total number of characters of the middle segment to
four.
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Display Files (e.g. Construction Documents, Wall Displays, anything
Plotted)
File Name
Standard Abbreviations/Legend Sheet
Title Sheet File
Drainage Area Map
Drainage Details Sheet
Drainage Schedule Sheet
Erosion & Sediment Control Detail Sheet
Erosion & Sediment Control Plan Sheet
Grading & Drainage Plan Sheet
Pipe Profiles Sheet
SWM Detail Sheet
SWM Grading Plan Sheet
SWM Pond Landscaping Plan Sheet
Landscaping Plan Sheet
Landscaping Profile Sheet
Reforestation Plans
Brochure Graphics - Alternates Mapping
Brochure Graphics - Typical Sections
Environmental Document - Alternate Mapping
Environmental Document - Typical Section
Landscaping Display Sheet
Landscaping Cross Section Display Sheet
R/W Cost Estimating Maps
Wall Display - Alternates Mapping
Wall Display - Study Area
Wall Display - Typical Section
Grading Table Earthwork Summary Sheet
Geometry Sheet
Highway Cross Section Plan Sheet
Highway Detail Sheet (i.e. Intersections)
Highway Design Plan Sheet
Highway Profile Sheet Files
Paving Detail Sheet
Typical Section Detail Sheet
Traffic Control Plan Sheet (MOT)
Superelevation Data Sheet
ITS Plan Sheet (Insert)
ITS Plan Sheet (Areawide)
Lighting Details
Lighting Plan Sheet (Insert)

DDOT CAD Standards

Abbreviation
pGN-I
pGN-T
pDA-P
pDD-D
pDD-S
pES-D
pES-P
pGR-P
pDP-V
pSW-D
pSW-P
pLD-P
pLD-P
pLP-X
pRF-P
pBG-AM
pBG-TS
pED-AM
pED-TS
pWD-LD
pWD-LP
pRW-M
pWD-AM
pWD-SA
pWD-TS
pGR-S
pGS-P
pHC-X
pHD-D
pHD-P
pHP-V
pHT-D
pHT-X
pMT-P
pSE-D
pIT-P
pIT-P
pLT-D
pLT-P
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Display Files - Continued

File Name
Lighting Plan Sheet (Areawide)
Lighting Schedule
General Information Signal Sheet (Insert)
Traffic Signalization Plan Sheet (Insert)
Traffic Signalization Plan Sheet (Areawide)
Signing Detail (Insert)
Steel Supports (Insert)
Structures
Signing Index Sheet (Insert)
Signing & Marking Plans (Insert, SN-2)
Signing Title Sheet (Insert, SN-1)
Abutment Details Sheet
Pier Details Sheet
Noise Abatement Displays
ROW Plats
Stream Restoration Plans
Wetlands Impact Plate
Wetlands Mitigation Plans

Abbreviation
pLT-P
pLT-S
pSG-N
pSG-P
pSG-P
pSN-D3
pSN-D4
pSN-DS
pSN-I
pSN-P
pSN-T
pBP-AD
pBP-PD
pNA-P
pRW-P
pSR-P
pWT-F
pWT-P

* use "standard" characters for file type(s) needed
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Proposed Design Model Files (e.g. Referenced Design Models)
File Name
Bridge Model, Plan
Bridge Model, Profile
Drainage Area Delineation Model, Proposed
Drainage Design Model
Erosion & Sediment Control Model
Drainage (Pipe) Profile Model
Grading (Proposed SWM Contours) Model
Noise Barrier Model
Landscaping Model, Proposed
Stream Restoration Model
Reforestation Model
Environmental Impacts Model
Land Use Delineation Model, Proposed
Wetlands Mitigation Model
Right Of Way Model, Proposed
Shading Model
Layout Model
Cross Section Alternates Model
Future Developments Model
Highway Horizontal Design Alternate Model
Highway Vertical Design Alternate Model
Right Of Way Model, Proposed
Highway Horizontal Design Model
Contours Model, Proposed
Utilities Model, Proposed
Layout Model
Rail Relocation Model
Shading Model
Temporary Traffic Phasing Topography Model (Topo to Remain)
Traffic Control Design Model (MOT)
Turning Movements
Highway Vertical Design (Profile) Model
ITS Model, Proposed
Lighting Model, Proposed
Signalization Model, Proposed
Signing Model, Proposed
Pavement Marking Model, Proposed

Abbreviation
mBD
mBP
mDA-P
mDD
mES
mDP
mGR-P
mNB
mLD
mSR
mRF
mEI
mLU-P
mWT-A01
mRW-PA01
**
mLA
mHC-A01
mFD
mHD-A01
mHP-A01
mRW-P
mHD
mGR-P
mUT-P
mLA
mRR
**
mTT
mMT
mAT
mHP
mIT-P
mLT-P
mSG-P
mSN-P
mPM-P

** shading may be addressed though alternate workflow, or in separate file named MSH
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Existing Design Model Files (e.g. Referenced Models)
File Name
Base Linen
Drainage Area Delineation Model, Existing
Environmental Features Model (inc Wetlands)
Land Use Delineation Model, Existing
Soils And Foundation Model
Soils Map
Right of Way Model, Existing
Contours Model, Existing
Topo Model (from Photogrammetry i.e.pln*.3d)
Topo Model, Compiled (from multiple sources)
Topo Model, Updated
Contours Model, Existing
Surface Triangles Model, Existing
Utilities Model, Existing
Metes & Bounds Model
Mosaic Model
Triangles from Mappers
Topographic Text Labels
Topography File
Work Map Plat Development (Existing R-O-W)
Changeable Message Sign Model
ITS Layout, Existing
Lighting Model, Existing
Pavement Marking Model, Existing
Signalization Model, Existing
Topo to Remain (see Proposed Models)
Signing Model, Existing
Soil Borings (bridge)
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xBL
mDA-E
mEF-E
mLU-E
mSO
mSM
mRW-E
mGR-EA
mTO-A
mTO-C
mTO-U
mGR-ES
mTR-E
mUT-E
mMB-E
mMO-E
mTR-E
mTX-E
mTO-S
mRW-E
mIT-E
mIT-E
mLT-E
mPM-E
mSG-E
mTT-E
mSN-E
mSO
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Detail Model Files (e.g. Referenced Detail Models)
File Name
Drainage Details
Erosion & Sediment Control Details
Storm Water Mangement Details
Pavement Details
Typical Section Details

Abbreviation
dDD
dES
dDD-SW
dHT-D
dHT-X

Support Files (e.g. Scratch Files/Specialized Civil Software Files)
File Name
Geopak Pattern Lines Model
Geopak Superelevation Shapes Model
InRoads Working Model
Roadway Quantity Shapes/Calculations Model
Air Quality Model

Abbreviation
sPT
sSH
sHD
sHD-Q
sAQ

Miscellaneous Files
File Name
Base Linen
Legend
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MD CAD STD V8 File Naming Convention (Bridge File Types)
File Name
Electrical Conduit Details

Abbreviation
dBD

Detail

dBD

Detail

dBD

Detail

dBD

Bridge Bearing Details

dBD-D

Bridge (Plan) Details - Joint

dBD-DJ

Bridge (Plan) Details - Miscellaneous

dBD-DM

Bridge (Plan) Details - Trough

dBD-DM

Detail

dBD-DM

Bridge (Plan) Details - Wing Walls

dBD-DW

Bridge Dead Load Diagrams

dBD-S

Bridge (Profile) Details - Abutments

dBP-DA

Bridge (Profile) Details - Footers

dBP-DF

Bridge (Profile) Details - Jacking

dBP-DM

Bridge (Profile) Details - Parapet

dBP-DM

Bridge (Profile) Details - Railing

dBP-DM

Bridge (Profile) Details - Pier
Drainage Details
Erosion & Sediment Control Details
Pavement Details
Typical Section Details

dBP-DP
dDD
dES
dHT-D
dHT-X

Bulkhead Elevation Details

dST-DB

Structural Wall Detail - Headwall

dST-DW

Structural Wall Detail - Retaining
Storm Water Mangement Details

dST-DW
dSW-D

Utility Details
Bridge Model, Plan

dUT-P
mBD

Bridge Model, Plan

mBD

Bridge Model, Plan

mBD

Bridge Model, Plan

mBD

Bridge Model, Profile
Bridge Model, Profile
Drainage Area Delineation Model, Existing
Drainage Area Delineation Model, Proposed
Drainage Design Model
Drainage (Pipe) Profile Model
Enviromental Features Model (inc Wetlands)
Environmental Impacts Model

mBP
mBP
mDA-E
mDA-P
mDD
mDP
mEF-E
mEI
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File Name

Abbreviation

Erosion & Sediment Control Model

mES

Contours Model, Existing

mGR-EA

Contours Model, Existing
Contours Model, Proposed

mGR-ES
mGR-P

Grading - Proposed
Grading (Proposed SWM Contours) Model
Highway Horizontal Design Model
Highway Horizontal Design Alternate Model
Highway Vertical Design (Profile) Model
Highway Vertical Design Alternate Model
ITS Model, Existing
ITS Model, Proposed
Lighting Model, Existing
Lighting Model, Proposed
Metes & Bounds Model
Mosaic Model
Traffic Control Design Model (MOT)
Noise Barrier Model
Pavement Marking Model, Existing

mGR-P
mGR-P
mHD
mHD-A01
mHP
mHP-A01
mIT-E
mIT-P
mLT-E
mLT-P
mMB-E
mMO-E
mMT
mNB
mPM-E

Pavement Marking Model, Proposed
Pavement Marking Model, Proposed
Rail Relocation Model
Right of Way Model, Existing
Work Map Plat Development (Existing R-O-W)
Right Of Way Model, Proposed
Right Of Way Model, Proposed

mPM-P
mPM-P
mRR
mRW-E
mRW-E
mRW-P
mRW-PA01

Sequence of Construction Model

mSC

Stream Diversion Model
Signalization Model, Existing
Signalization Model, Proposed
Soils Map
Signing Model, Existing
Signing Model, Proposed

mSD
mSG-E
mSG-P
mSM
mSN-E
mSN-P

Soil Borings Model (bridge)
Soils And Foundation Model
Stream Restoration Model

mSO
mSO
mSR

Bulkhead Elevation Model

mST

Structural Wall Model - Headwall

mST

Structural Wall Model - Retaining

mST
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File Name

Abbreviation

Topo Model (from Photogrammetry i.e.pln*.3d)
Topo Model, Compiled (from multiple sources)
Topography Model
Topo Model, Updated
Surface Triangles Model, Existing
Triangles from Mappers Model
Temporary Traffic Phasing Topography Model (Topo to Remain)
Topo to Remain Model (see Proposed Models)
Topographic Text Labels Model
Utilities Model, Existing
Utilities Model, Proposed
Wetlands Mitigation Model
Red Line Revision Sheet

mTO-A
mTO-C
mTO-S
mTO-U
mTR-E
mTR-E
mTT
mTT-E
mTX-E
mUT-E
mUT-P
mWT-A01
p**-*R

Bridge (Plan) Detail Sheet - Footings

pBD-DF

Bridge (Plan) Detail Sheet - Girder

pBD-DG

Bridge (Plan) Detail Sheet - Miscellaneous

pBD-DM

Bridge (Plan) Detail Sheet - Reinforcement

pBD-DR

Bridge (Plan) Detail Sheet - Standards

pBD-DS

Bridge (Plan) Detail Sheet - Walls

pBD-DW

Bridge Plan and Elevation Sheet

pBD-P

Electrical Conduit Sheet

pBD-P

Bridge Plan Sheet - Deck

pBD-PD

Bridge Plan Sheet - Girder

pBD-PG

Bridge Plan Sheet - Pier

pBD-PP

Bridge Schedules - Girder

pBD-SG

Bridge Hydraulics Schedules

pBD-SH

Bridge (Abutment) Details Sheet

pBP-DA

Bridge Framing Sheet

pBP-DG

Bridge Profile Sheet - Girder

pBP-PG

Bridge Sections Sheet - Typical

pBP-X

Bridge Sections Sheet - Walls

pBP-XW

Bridge Detail Sheet

pBT-D

Bridge Section Detail Sheet

pBT-X

Bridge Deck Section Detail Sheet
Drainage Area Map
Drainage Detail Sheet
Drainage Schedule Sheet
Pipe Profiles Sheet
Erosion & Sediment Control Detail Sheet
Erosion & Sediment Control Plan Sheet

pBT-XD
pDA-P
pDD-D
pDD-S
pDP-V
pES-D
pES-P

DDOT CAD Standards

Appendix C-9

2005

File Name

Abbreviation

Standard Abbreviations/Legend Sheet

pGN-I

Key Map

pGN-K

General Notes Sheet
Title Sheet
Grading & Drainage Plan Sheet
Grading Table Earthwork Summary Sheet

pGN-N
pGN-T
pGR-P
pGR-S

Geometry Sheet
Geometry Sheet

pGS-P
pGS-P

Geometry Stake Out Sheet
Highway Cross Section Plan Sheet
Highway Detail Sheet (i.e. Intersections)
Highway Design Plan Sheet
Highway Profile Sheet
Typical Section Detail Sheet
ITS Plan Sheet (Insert)
SWM Pond Landscaping Plan Sheet
Lighting Detail Sheet
Lighting Plan Sheet (Areawide)
Lighting Plan Sheet (Insert)
Lighting Schedule Sheet
Traffic Control Plan Sheet (MOT)
R/W Cost Estimating Maps

pGS-P
pHC-X
pHD-D
pHD-P
pHP-V
pHT-X
pIT-P
pLD-P
pLT-D
pLT-P
pLT-P
pLT-S
pMT-P
pRW-M

Stream Diversion Plan Sheet
Superelevation Data Sheet
General Information Signal Sheet (Insert)
Traffic Signalization Plan Sheet (Areawide)
Traffic Signalization Plan Sheet (Insert)
Signing Detail Sheet (Insert)
Steel Supports Sheet (Insert)
Structures Sheet
Signing Index Sheet (Insert)
Signing & Marking Plan Sheet (Insert, SN-2)
Signing Title Sheet (Insert, SN-1)

pSD-P
pSE-D
pSG-N
pSG-P
pSG-P
pSN-D3
pSN-D4
pSN-DS
pSN-I
pSN-P
pSN-T

Soil Borings Plan Sheet (bridge)
Stream Restoration Plans

pSO
pSR-P

Structural Culvert Detail Sheet

pST-DC

Structural Culvert Detail - Walls

pST-DW

Bulkhead Elevation Sheet

pST-PB

Structural Culvert Plan

pST-PC

Structural Wall Sheet - Headwall

pST-PW

Structural Wall Sheet - Retaining

pST-PW
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File Name
Structural Culvert Typical Section
SWM Detail Sheet
SWM Grading Plan Sheet
Utility Plan Sheet

Abbreviation
pST-XC
pSW-D
pSW-P
pUT-P

Wetland Permit
Wetlands Impact Plate
Wetlands Mitigation Plan Sheet
Base Linen
Layout Model

pWT
pWT-F
pWT-P
xBL
xLA

Legend

xLG
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Appendix D
MDSHA Cell Libraries

MDSHA has numerous cell libraries contained in multiple directories. These cell libraries
have been made available to DDOT personnel as well as to consultants without any
modification. The acronyms used in the cell library names or directory names are based on
the major divisions of MDSHA. Shown below is an explanation of the divisions and
responsibilities of such divisions at MDSHA, provided to make it easier to understand the
cell libraries’ directory structure. However, as stated earlier, the three cell libraries that
contains most, if not all, of the cells required on DDOT projects are named
DDOT_design.cel, DDOT_survey.cel and DDOT_traffic.cel.
•

The Office of Planning and Preliminary Engineering (OPPE) prepares
maps. OPPE coordinates statewide transportation planning with federal, state
and local agencies, and conducts preliminary engineering and alternate
analyses for budget planning purposes.

•

The Office of Highway Development (OHD) designs highway and support
structures like drainage systems along the selected alternative to meet design
guidelines. OHD conducts surveys to provide detailed topographic maps for
design. With six Divisions—Highway Design, Highway Hydraulics, Design
Technical Services, Communication Design, Plats and Surveys and
Engineering Access Permits, OHD oversees projects from the program stage
until they are advertised for construction.

•

The Office of Bridge Development (OBD) designs bridges and other
structures such as retaining walls and soundwalls, ensuring quality and safety
while employing the latest technologies.

•

The Office of Environmental Design (OED) deals with highway-related
environmental concerns, including sound barriers, retaining walls, landscapes,
forests, wetland mitigation, byways, rest areas and more.

•

District Offices perform design, construction, safety and maintenance for
highways falling under their jurisdictions.

•

The Office of Maintenance (OOM) is charged with the upkeep of state
streets and highways.

•

The Office of Materials and Technology (OMT) tests materials for the
planning, design, construction and maintenance offices, focusing on safety
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and durability. Contractors might use hot-mix asphalt, concrete, metals,
structural coatings and the like to build highways and structures.
•

The Office of Traffic and Safety (OOTS) designs lights, traffic signals,
street signs and traffic control devices and promotes highway safety.

•

The Office of Construction (OOC) deploys inspectors to investigate and rate
contractor effectiveness, ensuring project quality and safety.

•

The Office of Real Estate (ORE) deals with legal issues related to right-ofway acquisitions and property plats.

•

The Office of CHART and ITS Development deploys and monitors
intelligent transportation systems (ITS), such as cameras and sensors, to
promote intelligent traffic adjustments to maximize infrastructure usage.
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Appendix E
DDOT Custom Line Styles

UTILITIES AND PIPES 12
Exist (UG) Stormdrain Line < 24”
Exist (UG) Stromdrain Line >=
24”
Exist (UG) Stormdrain Line To
Be Abandoned
Exist (UG) Stormdrain Line To
Be Removed
Exist (UG) Sanitary Sewer Line <
24”
Exist (UG) Sanitary Sewer Line
>= 24”
Exist (UG) Sanitary Sewer Line
To Be Abandoned
Exist (UG) Sanitary Sewer Line
To Be Removed
Exist (UG) Combined Sewer Line
< 24”
Exist (UG) Combined Sewer Line
>=24”
Exist (UG) Combined Sewer Line
To Be Abandoned
Exist (UG) Combined Sewer To
Be Removed
Exist (UG) Water Line < 24”
Exist (UG) Water Line >= 24”
Exist (UG) Water Line To Be
Abandoned
Exist (UG) Water Line To Be
Removed

1

Note the term UG refers to an underground utility and applies to existing utilities. It is noted as such because that is part
of the linestyle name used in the CAD Workspace files.
2
Size and Type labels shall be added by the designer to all existing utilities and proposed stormdrain lines.
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Exist (UG) Electric Line
Exist (UG) Electric Line To Be
Abandoned
Exist (UG) Electric Line To Be
Removed
Exist (UG) Gas Line
Exist (UG) Gas Line To Be
Abandoned
Exist (UG) Gas Line To Be
Removed
Exist (UG) Telephone Line
Exist (UG) Telephone Line To Be
Abandoned
Exist (UG) Telephone Line To Be
Removed
Existing Underdrain
Proposed Underdrain
Prop Stormdrain Line < 24”
Prop Stormdrain Line >= 24”

TOPOGRAPHIC AND DESIGN
State Line
ROW
Building Restriction Line
Lot Line
Historic
Parkland
PFA
Bush Line
Wetland Boundary
Woods Line
Floodplain
Fence Existing, Type
Fence Proposed, Type
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Fence Gate
Existing Railroad
Existing Streetcar
Existing Guardrail – Double Face
Proposed Guardrail – Double
Face
Existing Guardrail – Single Face
Proposed Guardrail – Single
Face
Movable Barrier – 18 in Concrete
Movable Barrier - 24 in Steel
Noise Barrier Existing
Concrete Barrier Double Face
Concrete Barrier Single Face
Limit - Cut Line
Limit - Fill Line
Limit of Disturbance

TRAFFIC ITEMS
Conduit, Existing SL/TS
(Streetlight/Traffic Signal)
Conduit, Proposed PVC 2 - 4 in
Conduit, Proposed PVC 2 in
Conduit, Proposed PVC 2&4 in
Conduit, Proposed PVC 4 - 4 in
Conduit, Proposed PVC 4 in
Stripe Double Solid Skip Left
Stripe Double Solid Skip Right
Stripe Double Solid
Stripe Skip 10 30
Stripe Skip 2 6 (Elephant Track)
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Stripe Skip 3 9 (Puppy Track)
Stripe Skip HOV (Dinasaur
Track)

EROSION AND SEDIMENT CONTROL
Ditch Flow
Flow Path
Baffle Boards
Perimeter Dike/Swale-1

Perimeter Dike/Swale-2
Temporary Swale B-1
Temporary Swale B-2
Temporary Swale B-3
Temporary Swale A-1
Temporary Swale A-2
Temporary Swale A-3
Straw Bale Dike
Silt Fence
Super Silt Fence
Earthen Dike A-1
Earthen Dike A-2
Earthen Dike A-3
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